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Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be 
construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, 
Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice
© Copyright 2014 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe® is a trademark of Adobe Systems Incorporated.

Java is a registered trademark of Oracle and/or its affiliates.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online web site and search for the product manual called HP Service 
Manager Open Source and Third Party License Agreements.

Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:           http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:           http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.

Support
Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your 
business. As a valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest
l Submit and track support cases and enhancement requests
l Download software patches
l Manage support contracts
l Look up HP support contacts
l Review information about available services
l Enter into discussions with other software customers
l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

  http://h20229.www2.hp.com/passport-registration.html

Release Notes

HP Service Manager (9.34) Page 3 of 162



To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions to meet your business 
needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is 
http://h20230.www2.hp.com/sc/solutions/index.jsp
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Introduction to Service Manager 9.34
HP Service Manager 9.34 has been designed to provide a fresh look and feel to the web client while 
keeping the overall day-to-day user experience that users are used to. We improved usability by adding 
an optional auto-complete feature as well as a new date picker widget. The message bar got a 
makeover, and SRC users can now submit new requests with less clicks. We continue to support the 
Windows client but have not made any changes to it.

We didn’t stop at UI improvements: there is an entirely new change calendar feature as well as a case 
exchange framework so you can integrate Service Manager with other incident handling systems. We 
also added a new “delta migration” tool that automatically synchronizes changes between two Service 
Manager systems.

These great features and more are summarized in "What's new in this release" on page 9. But that’s not 
all… the journey of improving overall product quality didn’t stop either: we resolved over 200 defects 
and implemented over 20 customer-requested enhancements. And the Service Manager team is 
already busy working on the next set of features and product improvements. Stay tuned!

If you are running Service Managerin a Windows environment, we highly encourage you to download 
HP ITSM Deployment Manager and use it to re-deploy your environment when upgrading to Service 
Manager 9.34. Deployment Manager is a new free admin tool provided by HP to help you deploy and 
maintain your Service Manager environments as well as ease the setup and maintenance of Service 
Manager integration with other HP products. See this blog article for a quick overview: The new HP 
ITSM Deployment Manager will shorten your on premise software deployment. Deployment Manager 
can be download from HP Live Network for free and all related information regarding its compatibility 
matrix and features are accessible there: https://hpln.hp.com/group/itsm-deployment-manager

As always, we encourage you to actively participate in making Service Manager better. Please follow 
us on Twitter at @HPITSM, join our LinkedIn group "HP ITSM" or join the discussion on our blog.
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What's new in this release
This section describes the important changes in this release. 

Feature Prerequisites

User 
experience 
improvements 
in the web 
client

 l Service Manager 9.34 web client 

The Auto Complete features does not support applications versions prior to 9.32. 
Additionally, for applications versions 9.32 and 9.33, platform unload 
QCCR1E103581_SM934_SM932.unl shipped with Service Manager 9.34 must be 
loaded first to use Auto Complete. For details, see the Auto complete topic in the 
online help.

The Branding feature supports applications versions 7.11 through 9.34. However, 
for applications versions earlier than 9.34, the TAILORING menu record must be 
manually updated to enable the new branding interface. For details, see the 
Branding the web client topic in the online help. 

If you are running on an applications version earlier than 9.34, you may see a 
vertical scroll bar outside the subforms in some out-of-box wizards. To solve this 
issue, use the workaround provided in "User experience improvements in the web 
client" on the next page.

Case 
Exchange 
framework

 l Service Manager 9.34 server 

 l Service Manager 9.34 applications 

Service 
Manager 
Calendar

 l Service Manager 9.34 server

 l Service Manager 9.34 web client

 l Service Manager 9.34 applications 

Time Period 
Management

 l Service Manager 9.34 server 

 l Service Manager 9.34 applications 

Delta 
migration tool

Any version of Service Manager (SM): SC6.2, SM7.x, SM9.2x, and SM9.3x.

Note: For applications versions earlier than 9.34, DeltaMigrationTool.unl 
(which is shipped with the SM9.34 Upgrade package) must be loaded first. 

Text Import 
Wizard 
enhancements

 l Service Manager 9.34 server 

 l Service Manager 9.34 applications 
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Survey 
Integration 
enhancement

 l Service Manager 9.34 applications 

Support of 
multiple OMi 
servers

 l Service Manager 9.34 applications 

JavaScript 
engine 
performance 
improvements

 l Service Manager 9.34 server  

Caution: You need to disable mode “malloc” defined by server parameter 
“memmanager”.  Otherwise you may run into out-of-memory issues. 

Accessibility 
improvements

 l Service Manager 9.34 web client (with JAWS 13 for Internet Explorer  8 or 9, and 
JAWS 15 for Internet Explorer 10 or 11) 

Requesting 
support items 
from the ESS 
portal

 l Service Manager 9.34 applications 

New 
enhancements 
for Service 
Request 
Catalog

 l Service Manager 9.34 applications

 l Service Manager 9.34 Service Request Catalog web client 

KBI 
knowledge 
content

 l Service Manager 9.3x server

 l Service Manager 9.3x applications

 l Service Manager 9.3x Knowledge Management Search Engine

 l Service Manager 9.3x KM Import Utility

Tip: As of Service Manager 9.33, the "Installation Information" section of the patch detail page will 
contain a link to a knowledge base article that contains links to all the previous release notes and 
patches. This article enables you to always find the most up-to-date release notes and the latest 
9.3x patches:

http://support.openview.hp.com/selfsolve/document/KM00705452

User experience improvements in the web client
Service Manager 9.34 includes the following user experience improvements in the web client to reach a 
higher level of readability, efficiency, and consistency.
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New look and feel

The new look and feel of the web client follows a clean and modern design that aligns with the HP 
brand.  The new design refreshes almost all user interface (UI) elements, such as headers, toolbars, 
and icons.

 l The new design increases the size of some UI elements (for example, widgets and the space 
between widgets) to improve readability. 

 l The new UI elements are clean and simple, and the newly introduced icons are more meaningful. 

 l The new design uses fewer background colors. 

Note: If you use Internet Explorer, we recommend that you use Internet Explorer 10 or a higher 
version for better experience and performance.  Internet Explorer 8 has some known limitations, for 
example:

 l The browser cannot automatically adjust the size of the login graphic when the size of the 
browser window changes.

 l The browser does not support certain HTML styles. For example, round corners of a box and 
the shadow effect when an item is in focus.

All these improvements help users to focus on the information, so users can find the information they 
want more easily.

User interface backward compatibility

Service Manager 9.34 provides the following capabilities for you to bring back some of the UI elements 
and styles of Service Manager 9.33:

 l Bringing back the icons in toolbar and forms

In the event that you  prefer to retain the previous icons, you can download them from the HP Live 
Network: https://hpln.hp.com/node/6/otherfiles/?dir=20276

To apply the icons, follow the instructions in the following online help topic:

System Administration > Tailoring > Web tier > Branding the web client > Additional branding 
implementation options

 l Using the compact layout

The compact layout can bring back the page layout that is used in Service Manager 9.33. In your 
existing tailored forms, there is a possibility that the increased size of some UI elements in the new 
look and feel may introduce certain display issues, for example, truncated text or overlapped UI 
elements. You can use the compact layout to work around these issues. For more information, refer 
to the following online help topic:

System Administration > Tailoring > Web tier > Using the compact layout
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 l Resolving the vertical scroll bar issue in Wizards 

Use the following workaround to resolve the issue that a vertical scroll bar appears outside the 
subforms of some wizards:

 a. Go to Forms Designer. 

 b. Find the following forms for wizard templates: 

 o wizard

 o wizard.large 

 o wizard.list 

 o wizard.list.mult

 o wizard.okonly 

 o wizard.okonly.small

 o wizard.small

 c. Click Search.

 d. Click Design. 

 e. Perform the following adjustments to meet your needs:

 o Reduce the height of the "wizard.subformat" subform.

 o Move the buttons at the bottom to a higher position.

 o If the vertical scroll bar appears inside of the "wizard.subformat" subform, reduce the 
vertical space between widgets on the form that is contained in the subform.

 f. Click OK twice. 

Note: If you have language packs installed , perform the same steps for other languages. 
This solution also applies to Wizards created by yourself.  

Date picker

The new date picker for the Date control provides a more efficient way to select a date and time. The 
date picker no longer opens a new window.

Release Notes
What's new in this release

HP Service Manager (9.34) Page 12 of 162



 

The new date picker also supports keyboard shortcuts. For more information, refer to the following topic 
in the online help:

Getting Started > Clients > Web clients > Web client keyboard shortcuts

Auto complete

The auto complete functionality in the Comfill widget displays matching values as you type. You can 
quickly select a value from the list, so you no longer need to jump back and forth through pages to 
select the value for the field.

Caution: Be aware that the auto complete feature will consume additional system resources 
(memory and CPU) of the Service Manager server. If your server already runs at high capacity, HP 
recommends that you analyze and understand the impact before deployment (see the Service 
Manager 9.3x Deployment Sizing Guide for reference information). Note that this guide does not 
contain Service Manager 9.34 related information until some time after the release. 

The following table lists the parameters that control this feature. Their default values are intended 
to provide optimized user experience; however you may need to tune these parameters based on 
your system requirements to achieve balance between user experience and system performance. 
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Web parameter  
Default 
value Description 

"Web parameter: 
comfillAutoComplete" on 
page 45

true This parameter enables auto complete for the 
Comfill control. If you want to disable auto 
complete globally in Service Manager, set it to 
false.

To enable auto complete for a specific Comfill 
field, you must further enable the Auto Complete 
property of this Comfill control in Forms Designer. 
If this property is disabled, auto complete is 
disabled for this Comfill field regardless of the 
global comfillAutoComplete setting. 

"Web parameter: 
autoCompleteDelayTime" on 
page 41

200 
milliseconds 

This parameter defines the delay time in 
milliseconds to trigger the auto complete feature 
after you stop typing characters in a Comfill field.

"Web parameter: 
autoCompleteListSize" on 
page 42

10 records This parameter defines the maximum number of 
records that are fetched from the server side at 
one time and returned to an auto complete 
selection list.

"Web parameter: 
autoCompleteMinChars" on 
page 43

3 characters This parameter defines the minimum number of 
characters you must type in a Comfill widget to 
trigger the auto complete feature.

"Web parameter: 
autoCompleteSkipCachingChar" 
on page 44

/ (forward 
slash)

This parameter specifies a special character that 
is used in the Link records of some Comfill fields 
as a separator to split a single field value into 
multiple levels, such as "/" in "mycompany/Asia." 

For more information about how to configure the auto complete feature, see the following topic in the 
online help:

Guides and reference > Tailoring Best Practice Guide > Form tailoring > Selecting values from options 
in a control > Auto complete

Message bar

The new message bar floats over the page so that the content of the page no longer moves down. The 
message bar uses three background colors (green, yellow, and red) to identify the type of the message 
(info, warning, and error). For each type of messages, you can define whether the message bar appears 
and how long the messages are displayed. 
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For more information on how to configure the message display properties, refer to the following topic in 
the online help:

Guides and reference > System Configuration Parameters > Client parameters for web clients > Web 
parameter: message display properties

Message history box

The new message history box is modeless, which means you can perform other tasks in Service 
Manager while leaving this box open.  This feature is particularly helpful when you need to copy text 
from the message history box and paste the text into somewhere else in Service Manager. 

The new message history box no longer opens a new browser window, and hence is quicker than the 
old message history box.

Easy branding

In previous versions of HP Service Manager, there was no easy way to re-brand the web client to align 
with your corporate standards. 

Service Manager 9.34 provides a graphic user interface that facilitates the branding, tailoring, and 
upgrading of the web client. Now you no longer need to clear the browser cache after branding, and the 
new branding settings can take effect immediately. 
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Note: Techniques used previously to do Service Manager branding may not work any more. Also, 
the Branding feature supports applications versions 7.11 through 9.34. However, in applications 
earlier than version 9.34, you must manually update the TAILORING menu to enable the branding 
interface.

Tip: Your branding settings are stored in the folder you specify in web.xml parameter customize-
folder. To apply the branding settings from one Web tier to another, copy the customize-folder you 
specified from the source Web tier to the target Web tier.

For more information, refer to the following topic in the online help:

System Administration > Tailoring > Web tier > Branding the web client

If some of the current icons in Service Manger 9.34 become invisible when you set the background and 
the icon to the same color,  you can download the Service Manager 9.34 icons for special backgrounds 
from the HP Live Network: https://hpln.hp.com/node/6/otherfiles/?dir=20511. 

To apply the icons, follow the instructions in the following online help topic:

System Administration > Tailoring > Web tier > Branding the web client > Additional branding 
implementation options

For step-by-step instructions and branding examples, see white paper Branding the Service Manager 
web client.
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Case Exchange framework
HP Service Manager Case Exchange is a solution to exchange data between two Service Manager 
systems or between Service Manager and another product. The Case Exchange framework mainly 
facilitates the following operations:

 l Sending and receiving data

 l Viewing and processing the exchanged data in the native environment

The Case Exchange framework enhances the existing Service Manager Integration Suite (SMIS), 
which provides an interface to enable the Case Exchange solution. Case Exchange takes advantage of 
SMIS and provides the following core features:

 l Connector

Case Exchange is enabled by connectors, which can open, update, and close records in the 
ticketing system of another provider. Connectors can also perform the following tasks:

 n Listen for events or updates related to ticket exchange.

 n Take care of the physical communication to the ticketing system via REST-based web services 
in JSON format.

 n Manage appropriate authentication and identity credentials required by the connected ticketing 
system.

 l Field mapping and value mapping

Field mapping and value mapping determine how the record data is transformed into the internal or 
external normalized case format.

Field mapping ensures that the data from one system is send to the correct field on the second 
system. To avoid interface failures the field names and the field name description should not 
contain any special characters.

Value mapping ensures the data is correctly transformed according to the rules required in each 
system. The value mapping supports expressions and calculations to ensure the data is correctly 
manipulated prior to sending or updating records in the local database.

 l Outbound trigger rules

The outbound trigger rules determine which kind of record shall be sent to the external system. The 
Case Exchange framework includes a dedicated rule type in Rule Sets. This type of rules can 
trigger the Case Exchange request from Service Manager to the integrated systems. 
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If Process Designer is implemented in the object of the exchanging record, you can invoke a Rule 
Set from workflows. However, if Process Designer is not implemented, you must invoke a Rule Set 
from the table trigger by using the following new API:  

lib.CaseExchange_RuleExecute.executeSingleRuleSet (record,oldrecord,RuleSetID)

 l Error handling

In addition to the existing retry mechanism on the failed exchange request, the Case Exchange 
framework introduces this new feature to better handle errors. With this feature, SMIS can 
automatically submit a new Incident record for the failed exchange request.

 l Audit and logging

For administrators, the Case Exchange framework introduces the new SMIS task log feature to 
track all transactions of exchange requests. Administrators can access this log from SMIS. For 
users, the Case Exchange framework introduces the Case Exchange section in the Incident record 
detail. When a Case Exchange integration instance is active and a Case Exchange task has 
occurred to an Incident record, the Case Exchange section appears and contains the details of the 
Case Exchange information.  

With these core features of the Case Exchange framework, you can set up the Case Exchange 
integration with an easy and flexible approach. 

For more information about the Case Exchange framework, refer to the following section in the online 
help:

System Administration > Integrations > Case Exchange framework

SMIS enhancements

To enable the Case Exchange framework, SMIS includes the following enhancements:

 l Integration templates for Case Exchange

SMIS includes an out-of-box template for the Case Exchange integration: 
CaseExchangeDefaultTemplate. When you set up the integration, you can use and modify the 
out-of-box template as needed.

 l Dynamic connector form

Instead of the legacy table format, connector parameters are currently maintained within a dynamic 
form, which is customizable in the SMIS template.

 l Configurable background scheduler

To save system resources, multiple integration instances can share the same background 
scheduler. When you create an integration template, you can define a default shared scheduler for 
the instances that are based on this template. All instances that are based on this template can use 
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the same shared scheduler. However, if you create an instance that specifies a different scheduler, 
SMIS creates a new scheduler accordingly.

 l Task log

The SMIS task log keeps all transactions of exchange requests.  An integration administrator or a 
user has access to the SMIS task log to view the transaction details. A log entry in the SMIS task 
log always links to a task in the SMIS task queue. Through the link, you can manually solve an 
unsuccessful exchange request when needed.    

 l Field Mapping

Field mapping has the following enhancements:

 n Field Mapping is currently configurable in the SMIS template. You can directly import the field 
mappings from the template when you create a SMIS instance.

 n You can specify an Alias when you define the field, and use the Alias in value mapping to 
represent the field.

 n Field mapping introduces a new field type: variable, which can be used to define a variable 
field. For example, the Update field (activity log) for the Incident object.

 n When you use the when callback function in field mapping, you can define multiple entities with 
different conditions, and use placeholders to express a condition that is more complex than true 
and false. For more information about how to use placeholders, refer to the following topic in the 
online help:

System Administration > Integrations > Service Manager integration methods and tools > 
Integration Manager > Add or delete an integration instance > Integration Instance Mapping > 
Use placeholders

 l Value Mapping

Value mapping has the following enhancements:

 n When you configure value mapping entries, you can set a condition to an  entry. The condition 
can be true, false, or an expression that uses placeholder. For more information about how to 
set a condition for a value mapping entry, refer to the following topic in the online help:

System Administration > Integrations > Service Manager integration methods and tools > 
Integration Manager > Add or delete an integration instance > Integration Instance Mapping >  
Configure a condition

 n To make the value mapping customization more flexible, SMIS introduces the pre script and 
post script. For more information, refer to  Pre script and Post script in the online help under the 
following  path:

System Administration > Integrations > Service Manager integration methods and tools > 
Integration Manager > Add or delete an integration instance
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Service Manager Calendar
Prior to version 9.34, HP Service Manager allowed you to set up a  calendar through the Release 
Control integration. As of version 9.34, Service Manager additionally provides a  calendar that is based 
on the Calendar widget. Service Manager Calendar can display time period records and associated 
business records  in a graphic and intuitive user interface. It enables users  to perform the following  
tasks and optimize their task planning accordingly:

 l To easily see how their activities will be affected in a specific time range. For example, they can 
see if a performance degradation or service outage will happen this week.

 l To easily see which business records (changes, incidents, interactions, and so on) are  scheduled 
for or associated with  a specific time range. For example, they can see if a change is planned to 
start or end this week.

 l To directly view important details of time period records and associated records from tooltips.

 l To directly open records from the calendar to view their details. 

 l To view time conflicts of object records from either conflict icon tooltips and shadow bars. 

Service Manager Calendar also allows high-level tailoring through a set of configurations. For time 
period records and associated records, you can set color preferences, maximum number of records to 
display, field mappings, filters, and so on.

Enable Service Manager Calendar

Caution: Calendar will consume additional system resources (memory and CPU). Therefore, if 
you plan to embed the calendar in forms that are heavily used in your organization’s daily operation 
(such as incident or interaction forms), and if your server already runs at high capacity, HP 
recommends that you analyze and understand the impact before deployment (see the Service 
Manager 9.3x Deployment Sizing Guide for reference information). Note that this guide does not 
contain Service Manager 9.34 related information until some time after the release. 

By default, Service Manager Calendar is disabled and the Release Control  Calendar is used. To use 
Service Manager Calendar instead of the Release Control Calendar, perform the following steps: 

 1. Log in to Service Manager as a system administrator. 

 2. Click System Administration > Base System Configuration > Miscellaneous > System 
Information Record.

 3. On the General tab, select the Enable Calendar and Time Period Management option.               

 4. Click Save.                     
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 Launch Service Manager Calendar (web client only)

Calendar is not accessible from the Windows client. If you click Calendar from the System Navigator 
in the Windows client, a message displays instead, indicating this feature is available only from the 
web client.

To launch Calendar from the web client, click Miscellaneous > Calendar from the System Navigator. 
Calendar opens. See the following figure.

Note: When the Enable Calendar and Time Period Management option  is not selected, the 
Release Control Calendar is used. If the Release Control  Calendar is not set up, an error message 
occurs when you click Miscellaneous > Calendar.

Callout Description 

1 The date picker panel. You can use the arrow buttons on this panel to 
quickly jump to a specific year/month/date.

2 The Time Period record list panel, which is the upper part of the record list 
area. Note that the record list area is also referred to as the "Title area" of 
the calendar. 

This panel lists the time period records being displayed in the current 
calendar view, based on the settings in the Title Configuration section in 
System Administration > Ongoing Maintenance > Calendar 
Administration > Calendar Mappings. 
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Callout Description 

3 The Time Period graphic view panel, which is the upper part of the right-
side area of the calendar ("calendar entry area"). This panel displays time 
period occurrences as a single-color bar, and the length of each bar 
represents an occurrence duration. 

Note: This panel displays only active time period occurrences.

4 The time zone area, which displays the  time zone that is defined in the 
current user's operator record, or the one defined in the System Information 
Record if the former does not exist.

Note: If neither exists, this area displays Time Zone (undefined).

5 The Refresh button, used to fresh the calendar display. 

6 The filter panel, used to manage filtered views of the calendar. This filtering 
feature helps users locate data of their interest.

On the filter panel, users can add individual filter fields and field groups.

7 Conflict icons. Each of these icons indicates that the current record has 
conflicts with one or more time periods of the Freeze Period or 
Maintenance Window type, or has one or more custom messages 
configured, or both. These icons have tooltips that show specific conflict 
information and custom messages.

A record that has conflicts is one that exceeds, or misses, or overlaps with 
a Freeze Period or Maintenance Window time period. When it has conflicts 
only with maintenance windows, a yellow icon is displayed; as long as it 
has conflicts with freeze periods, a red icon is displayed; if it has no 
conflicts but has only custom messages configured, a blue icon is 
displayed.

Conflicts and overlaps are also indicated by gray background bars 
("shadow bars") behind the records bars. The more time periods a record 
has conflicts with, the darker the shadow bar becomes.

8 This button collapses the entire left-side panel (which consists of the date 
picker panel and the filter panel).

9 The object record list panel, which is the lower part of the record list panel 
("Title area"). This panel lists object records that are associated with the 
current time range. For example, this panel may list a Change record 
whose Planned Start or Planned End time falls into the currently displayed 
time range. The Calendar Settings and Calendar Mapping configurations 
determine which records are displayed in this area. 

10 This  button collapses the entire time period  panel.
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Callout Description 

11 The graphic view panel of object records, which is the lower part of the 
"calendar entry area". This panel displays relevant object records as a 
single-color bar to provide an intuitive view of the start and end times of 
these records. Administrators can use different colors to identify different 
records.

View Embedded Calendar from Change Management

The embedded calendar is a simplified view of the Calendar. Out of box, it is accessible only from 
Change Management (the  Calendar section in a Change or a Change Task record). The embedded 
calendar displays information about time periods and object records in a way that is more relevant to 
the current record. 

Load Calendar demo data

You can download demo data for Calendar from the HP Live Network website: 
https://hpln.hp.com/node/6/otherfiles/?dir=20274

You can load the demo data to your testing system to see examples of how to set up Calendar. 

More information

For information on how to configure and work with Service Manager Calendar, see the following section 
in the online help:

System Administration > Calendar Administration

Time Period Management
A time period definition is a set of settings that defines a type of time windows based on a set of 
recurrence rules, including its category, current phase (based on a pre-configured workflow), approval 
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status, scope, assignment group, owner, affected services, affected departments, and affected 
locations. Time Period Management enables you to perform the following tasks:

 l Define Local, Regional, or Global time periods that apply to a specific set of or all locations 
(countries or regions) in your organization.

 l Define which departments, business services, environment type (for example, production or test) 
the time periods apply to. 

 l Define the scope of each time period to indicate whether it will cause performance degradation or 
service outage to end users or it will have no impact on end user's activities. 

You can use Time Period Management to manage time period definitions for your organization so that 
end users can see how their activities will be affected during different time periods. If integrated with 
another module in HP Service Manager, Time Period Management will enable you to directly view time 
periods from that module. For example, if integrated with Change Management, time period definitions 
will enable users to view time periods and changes in a Calendar widget and view time periods and 
changes in the context of a selected change. This is helpful for change planning.

Delta migration tool
As of version 9.34, Service Manager provides a delta migration tool to transfer the “delta data” from one 
Service Manager system (original system) to another (new system).

For more information, see the following topic in the Service Manager online help:

System Administration > Delta migration tool

Typical scenario

There are times when you need to migrate data from one Service Manager server to another.  Take the 
following scenario:

 l The original system is running live

 l You make a copy of it

 l You make changes to the workflow in the copy

 l You replace the original live system with the copy that has the new workflow

Of course from the time you made a copy until the time the new system goes live, end users are 
making changes. The following figure depicts this scenario.  
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Tip: You can also use this tool to keep the data in a “test” system in sync with a “production” 
system or a “development” system in sync with a “test” system.

Data migration methods

The delta migration tool enables you to keep the original system and the copy in sync in either of the 
ways:

 l Allowing manual export or import of changed records

 l Scheduling an automated export or import

Caution: For a table without the “sysmodtime” field, the tool cannot migrate “delta data” from the 
original system.

Prerequisites

There are some prerequisites for using this tool. For details, see the  online help.

Supported applications versions

This tool is already available in Service Manager 9.34 applications; to use this tool on earlier 
applications versions, you need to load DeltaMigrationTool.unl, which you can find in the  root folder 
of the Service Manager 9.34 Upgrade package.

Text Import Wizard enhancements
The Text Import Wizard is enhanced to better support importing of data in CSV (Comma Separated 
Values) format into Service Manager. For example, the wizard now can import master data (such as 
Roles, Categories) and business data (such as Contacts, Departments, Assignment Groups, Service 
Catalog Items, and Configuration Items).

The enhancements are described in the following. For more information, see the following topics in the 
online help:
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 l System Administration > Database Administration > Data persistence > Importing records > Add 
an import descriptor record

 l System Administration > Database Administration > Data persistence > Importing records > Import 
a character-delimited text file

Support of mapping between source columns and target fields

Previously, the order of columns in the source CSV file had to match the exact order of the fields in the 
destination file (table) in Service Manager, as shown in the following figure. However, the order of 
columns in the CSV file and/or the data structure in Service Manager may change over time, making 
imports fail.

In Service Manager 9.34, this matching is no longer required. You can specify a mapping between the 
source columns and the destination table fields. The following figure shows an example mapping for the 
contacts table.

This mapping capability saves time on preparing source data. As long as the column headers remain 
the same, the Text Import Wizard can recognize the columns by column header, regardless of the order 
of columns in the source file. See the following figure for an example.
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 Support of complex data structure

The Text Import Wizard now can handle CSV files with a complex data structure, such as XML 
segment fields (for example, Service Catalog user options and connector information), array structure 
fields, and array type fields.

To achieve this, a new field, Array Separator, is added, which enables you to specify the separator of 
the array data in your source file so that the wizard can handle the data correctly. Two separators are 
supported: semicolon, and line break.

Support of data manipulation

The Text Import Wizard now enables you to manipulate the source data during import by specifying 
JavaScript expressions. This is implemented though the addition of the Javascript field on the 
Advanced tab.

For example, when importing your Outlook contacts information into the contacts table in Service 
Manager, you can specify the following JavaScript expressions:

target['contact.name']=source['First Name']+'.'+source['Last Name'];

target['company']='HP1';
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The first expression combines the First Name and Last Name columns in the source file and import the 
combined value into the Contact Name field in the destination table, and the second one sets all of the 
Company Names in the destination table to "HP1".

External CSV source file requirements

To use the Text Import Wizard , external CSV source files should meet the requirements described in 
the following table.

Requirement Note

Only plaint text files are 
supported.

Be sure to not load binary files, such as .JPG and .XLS files.

If the source data contains non-
ASCII characters,  the external 
text file must use UTF-8 or 
Unicode encoding. 

 

Column headers in the external 
file are mandatory and must be 
unique. 

CSV files with duplicate column headers cannot be imported. 
The wizard displays a warning on the duplicate columns and is 
not able to proceed. 

Make sure your source file contains column headers on the first 
line, and remove or rename duplicate columns as needed.

Column headers in source files 
should follow the JavaScript 
Identifier Naming conventions. 

Column headers in source files are used as JavaScript 
identifiers in this feature.

The number of values in a row 
must match the number of 
column headers.

If the number of values in a row does not match the number of 
column headers, the row is skipped. For example, if your source 
file contains 6 column headers, a row with more or less than 6 
values is skipped.

Make sure your source file does not contain invalid rows.

Source files cannot be huge. When a source file is huge (more than 15, 000 lines or 10 MB in 
size), it may take a  long time to load the file.

You are recommended to split a huge file to smaller ones before 
loading.

Numbers in the source files must 
be in raw format (without digit 
grouping). 

Digit grouping is not supported and only numbers in raw format 
can be imported.

For example, "1, 000.000, 3" cannot be correctly recognized. 
You must change it to "1000.0003".

Source data must match the 
data constraints that are defined 
in the target dbdict. 

Unique keys are not automatically generated during the import 
operation. Make sure that the records to import match the data 
constraints that are defined in their dbdict. 
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Requirement Note

Delimiters in external CSV files 
can be one of the following:

 l a comma 

 l a tab

 l a semicolon

 l a user-defined character 
other than listed above

When a field value contains the delimiter character, enclose the 
value in double quotes. 

For example:  "abc,def"

The following  date formats are 
supported for external source 
files: 

 l mm/dd/yy [hh:ii:ss] 

 l yy/mm/dd [hh:ii:ss] 

 l dd/mm/yy [hh:ii:ss]

Note: [hh:ii:ss] is optional. 

Make sure your source data uses the correct date format. You 
will need to specify the correct date format later when adding an 
import descriptor for the source file. 

Note: After importing, the imported data is converted to 
use the login user's date format.

Other requirements for importing

Requirement Description

Solving 
validations or 
dependencies 
before the 
import

Triggers are enabled during importing. For this reason, you may need to resolve 
some validations or dependencies first. 

For example, before loading a contact record, an operator record must be loaded 
first. Otherwise, a message, for example, “No operator record to sync”, pops up.

Importing data 
to required 
join tables

Some joinfiles need to be loaded completely to achieve desired data import 
results. For example, when importing service catalog items, you also need to load 
the service catalog display records concurrently. Otherwise, the imported records 
are not displayed correctly in the catalog.

Limitations

 l Scheduled import is not supported for character-delimited files.

 l For the optional Format Control record, only the following sections are supported: Calculations, 
JavaScript, and Validations.
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Survey Integration enhancement
HP Service Manager introduces a new API-based survey connector that enables you to integrate 
Service Manager with the third-party Medallia survey tool.

Out-of-box deployments of Service Manager 9.34 now include the following types of  survey connector. 

ID Name Description

001 API Connector -        Market Tools        An API-based connector that 
uploads data directly to the 
Market Tools survey       solution

002  URL Connector  An URL-based connector. When 
you use this connector to 
manage a survey,        survey 
recipients are emailed a URL that 
points to the survey         

003  API Connector -        Medallia An API-based connector that 
uploads data directly to the 
Medallia survey        solution 

Note: If you are running on applications version 9.32 or 9.33, you can still use this feature by 
applying the following content pack  from the HP Live 
Network:https://hpln.hp.com/group/survey-integration-content-service-manager

For more information about Medallia, visit the following website: http://www.medallia.com/

For more information, see the following section in the online help:

System Administration > Integrations > Survey Integration

Support of multiple OMi servers
The Incident Exchange (OMi - SM) integration is enhanced to support more than one OMi server. 

Backward compatibility

If you have a previous version of the Incident Exchange (OMi - SM) integration already set up in your 
system and do not need multiple OMi servers, you do not need to make any changes to your existing 
integration configuration.   

Additional configurations required for this support 

If you need multiple OMi servers, in addition to those steps required in previous releases, you need to 
complete the following additional configurations:
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 1. Configure the Instance Count setting in the SMOMi integration template.

 a. Log on to Service Manager as a system administrator.

 b. Type db in the command line, and press Enter.

 c. In the Table field, type SMISRegistry, and click Search. The SMIS integration template form 
opens.

 d. Click Search. A list of SMIS integration templates opens.

 e. Select SMOMi from the list.

 f. In the Instance Count field, change the value of 1 to the number of OMi servers that you want 
to integrate with Service Manager. For example, if you need two OMi servers, change the 
value to 2.

 g. Click Save.

 2. In Integration Manager, create and enable an integration instance for each OMi server, and 
additionally specify a new parameter, omi.mgr.id, for each instance.

Field 
Sample 
value Description 

omi.mgr.id f3832ff4-
a6b9-4228-
9fed-
b79105afa3e4

The Universally Unique Identifier (UUID) automatically generated 
in OMi for the target Service Manager server. It is the ID string you 
can find by right-clicking the Service Manager server configuration 
entry pane in the Connected Servers section in OMi.

Note: This parameter was introduced to support multiple OMi 
servers. Service Manager uses the UUID to identify from 
which OMi server an incident was opened. Be aware that if 
you delete the connected server configuration for the Service 
Manager server in OMi and then recreate the same 
configuration, OMi generates a new UUID. You need to 
reconfigure the integration instance by changing the old UUID 
to the new one.

Tip: If you have only one OMi server, you can simply remove 
this parameter (remove both the parameter name and value) 
from the integration instance. 

Caution: Starting with the Service Manager 9.34 release,  the View OMi Event option is not 
available from the More options menu in an OMi created Incident record, unless the 
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omi.mgr.id parameter in the corresponding  integration instance is set correctly.

For more information, see the following section in the online help:

System Administration > Integrations > HP Business Service Management (BSM) > BSM Operations 
Manager i (OMi)

JavaScript engine performance improvements
Prior to the Service Manager 9.34 release, when  creating a JavaScript host object, Service Manager 
initialized the object from scratch. This process was time-consuming and memory-consuming.

Service Manager 9.34 improves the JavaScript engine performance through the following 
implementations (see also enhancement "QCCR1E101012" on page 58):

 l Setting the prototype of a newly created JavaScript object instead of initializing the object from 
scratch

 l For a JavaScript class instance that should be a singleton, caching the instance object instead of 
creating a new object every time

These improvements significantly reduce JavaScript engine memory usage, so that JavaScript engine 
garbage collection occurs less frequently than before.

Also, server parameter “gcthreshold” is introduced to monitor Service Manager server memory usage 
increase and trigger JavaScript engine garbage collection when a memory increase reaches a specified 
threshold. This way, the Service Manager server native heap memory is freed in a timely manner.

Note: If you have set memory allocation mode to “malloc” through parameter “memmanager”, you 
need to remove it. This is because “gcthreshold” cannot detect increases of memory allocated by 
the Service Manager server unless in the default memory allocation mode. Failure to do so may 
cause you to run into out-of-memory issues.

Accessibility improvements
HP Service Manager 9.34 includes the following accessibility improvements.

Support of JAWS 13 and JAWS 15

Only these versions of JAWS are supported. Be aware that JAWS 13 must be used with Internet 
Explorer 8 or 9, and JAWS 15 must be used with Internet Explorer  10 or 11.

Accessibility support for the Table control

In Service Manager versions earlier than  9.34, the following issues exist:
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 l Record lists are not recognizable by JAWS as a table. As a result, you cannot use many table 
control features in JAWS. 

 l Table controls in a record details form are not read correctly by JAWS and are not accessible by 
using the Tab key.

In Service Manager 9.34, a new property Accessible Description has been added for the Table 
control.

Property Description 

Accessible 
Description

Specify a component description for use with accessibility software (JAWS). 
(Optional)

Note: This function is supported only by the Web client.

If no description is present, the Web client uses the default table summary as 
described below:

 l For a record list on a list page or on the list panel of a list-detail page: Record List 
+ [grouped by] + [sorted by] + [ascending/descending]

For example: Record List Sorted by Update Time Ascending 11x51

 l For a Table widget on a detail form: Table

For example: Table 4x3

The following behavior now applies:

 l JAWS recognizes a record list as a table and recognizes the pagination bar as a region. You can 
navigate through the record list by using JAWS table keystrokes and move the focus to the record 
list pagination bar using the JAWS Region List keystroke (Insert+ Ctrl + ; in JAWS 13 or Insert + 
Ctrl + R in JAWS 15). JAWS can also report the current sort state of the record list in Internet 
Explorer 10 or 11.

 l JAWS recognizes a table control on a record details form as a table, and you can tab through the 
column headers by using JAWS keystrokes. You can use Insert+ Ctrl+ T to  list all tables, or press 
and then release Insert + Space, followed by T to get to the table layer. 

Keyboard shortcuts for record list tables

The following table lists the keyboard shortcuts that can be used on a record list. 

Note: These shortcuts are not working when the JAWS virtual PC cursor mode is enabled.
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Shortcut Description Notes 

Ctrl + 
Home

 l Non-grouped record list: Move the focus to the first cell of 
the first row. 

 l Grouped record list: Move the focus to the first group 
node.

 

Ctrl + End  l Non-grouped record list: Move the focus to the last cell of 
the last row. 

 l Grouped record list: Move the focus to the last group 
node or to the last cell of the last row if the last group is 
expanded.

 

Ctrl + 
Page 
Up/Down

Navigate to the previous/next page of a non-grouped record 
list. 

In Chrome, use Alt + 
Page Up/Down 
instead.

Home
/End

When focusing on a cell in a row of a record list, move the 
focus to the first/last cell of the row.

 

Limitations

The following table accessibility limitations exist:

 l Table accessibility support is not implemented for the following modules: Process Designer, and 
Calendar.

 l JAWS 13 cannot read the Open Calendar icon in a table if you use Internet Explorer (IE) 8 or 9.

 l JAWS cannot read out the sort state of a sorted column in IE8/IE9, because IE8 and IE9 do not 
support the aria-sort property.

 l In ToDo queue, if the focus is outside the record list, the virtual cursor cannot move to the record list 
when using JAWS 15 keystrokes (T, or Insert + Ctrl + T). You can move the focus to the record list 
first by using the Tab key, and then navigate through the record list by using JAWS table 
keystrokes.

Requesting non-cart/support items from  the ESS 
portal
Prior to the Service Manager 9.34 release, Support type categories and items were accessible through 
Service Request Catalog (SRC), but not through the Employee Self-Service (ESS) portal.

Service Manager 9.34 provides a new option, Non-cart Catalog Requests, which allows ESS users to 
submit requests for non-cart (including Support type) items. To submit a request for a non-cart/support 
item, perform the following steps:
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 1. Log on to the Service Manager ess.do client.

 2. Click Miscellaneous > Non-cart Catalog Requests. 

 3. Locate the item you want through a search. 

Note: Only non-cart items are returned in the search results.

 4. Open the item, provide necessary information, and submit the request.

 

New enhancements for Service Request Catalog
Service Request Catalog 9.34 introduces the following new  enhancements.

User experience improvements to the request submission process

All panels are expanded by default, you do not need to click the Next button to complete a request. 
Therefore, you are not blocked by mandatory fields, and  can view and edit any section directly. 
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Additionally, all sections can be expanded or collapsed. You can click the Expand All and Collapse 
All buttons for all sections or to click the Expand and Collapse arrow buttons for a single section to 
improve the readability for the long scrolling screen.

Ability to change your password

You can now change your expired password during your login to Service Request Catalog. If your 
password has expired during your login, you are required to change your password.

To change your expired password, follow these steps:

 1. Log on to Service Request Catalog. The change password form opens if your password has 
expired.

 2. Type your new password in the New password and Confirm new password text boxes, and 
then click OK to save your change. The login page opens.

 3. Enter your new password to log on to Service Request Catalog. 

KBI knowledge content
The KBI-Content-Shipment.zip file in the Knowledge Management package includes knowledge 
articles provided by KnowledgeBroker, Inc. (KBI) for HP Service Manager. It contains thousands of 
immediate, out-of-the-box answers to questions for more than 190 Desktop and Internet applications. 
This powerful database is fully integrated with HP Service Manager. Used by Help Desk Analysts and 
end users for self-service, the KBI KnowledgeBase saves time, cuts costs, streamlines the support 
process and supports KCS and ITIL compliance. KnowledgeBase content is a key Help Desk 
component for resolving problems with computer software efficiently and effectively. 

Import the KBI demo data

To import the KBI knowledge articles, you must have the following software installed in your system:

 l HP Service Manager 9.3x server and applications

 l HP Service Manager 9.3x Search Engine

 l Java SDK

 l HP Service Manager 9.3x KM Import Utility

The KBI KnowledgeBase imports into Service Manager through the Service Manager KM Import Utility. 
The import has been optimized to utilize the capabilities, features and function sets of Service 
Manager. The total size of the demo data is approximately 400 Megabytes. 

For instructions on how to import the KBI demo data into Service Manager, see the README file 
packaged in the KM Import Utility (km-import-9.34.zip).

Verify the import

When the content starts importing you will see 'success' as each article is added.  When the import is 
complete, you will see a summary that shows the total number of articles imported. Play close 
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attention to skipped documents, rejected documents, and skipped attachments.  If, for any reason, 
there is an error or a document is rejected or skipped, it will be listed. 

Verify the integration

When you import KBI's demo data into HP Service Manager, the import automatically creates a three-
tiered category structure. 

To see the category structure, perform the following steps: 

 1. Go to Knowledge Management> Configuration> KM Document Categories.  

 2. On the Browse Categories tab, the KnowledgeBroker category is an easy way to identify all of 
the content from KnowedgeBroker. To see the category details, highlight KnowledgeBroker, and 
click More > Details. The two subcategories display.

To view all of the KBI knowledge articles imported, perform the following steps:

 1. Click Knowledge Management > Search Knowledgebase.

 2. In the search box, enter KBI.

 3. Click Search. A list of KBI knowledge articles displays. You can change the page size at the 
bottom of the screen and click the Next Page button to navigate through the knowledge articles.

New parameters
This release introduces the following new parameters.

Parameter: maxattachmentcount
Startup parameters change the behavior of the HP Service Manager server. You can always set a 
startup parameter from the server's operating system command prompt.

Parameter

maxattachmentcount

Description

This parameter specifies the maximum number of files that can be attached to an individual record. If 
this limit is being exceeded,  attachment uploading fails with the following error displayed on the user 
interface:

"The total number of attachments in this record exceeds the maximum allowed number for a 
single record."

The same error message is returned in the response if you attempt to add attachments through a SOAP 
or RESTful call and the number of attachments exceeds this limit.
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Note: If an existing record has already more attachments than allowed by maxattachmentcount, 
the existing attachments are retained, but uploading of new attachments will fail.

Valid if set from

Server's operating system command prompt

Initialization file (sm.ini)

Requires restart of the Service Manager server?

Yes

Default value

100

Possible values

0 to unlimited

Example usage

Command line: sm -httpPort:13080 -maxattachmentcount:100

Initialization file: maxattachmentcount:100

Startup parameter: restaccessviabrowser
Startup parameters change the behavior of the HP Service Manager server. You can always set a 
startup parameter from the server's operating system command prompt.

Parameter

restaccessviabrowser

Description

This parameter determines if RESTful access to the Service Manager server through a web browser is 
allowed. You can specify 0 or 1 for this parameter:

 l 0: Access to Service Manager through REST from a web browser is not allowed

 l 1: Access to Service Manager through REST from a web browser is allowed

Valid if set from

Server's operating system command prompt

Initialization file (sm.ini)

Requires restart of the Service Manager server?

Yes

Default value
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0

Possible values

0, 1 

Example usage

Command line: sm -httpPort:13080 -restaccessviabrowser:1

Initialization file: restaccessviabrowser:1

Parameter: gcthreshold
Startup parameters change the behavior of the HP Service Manager server. You can always set a 
startup parameter from the server's operating system command prompt.

Parameter

gcthreshold

Description

This parameter is used to prevent the native heap from running out of memory. It  specifies the threshold 
(in megabytes) at which an increase in native heap usage in HP Service Manager triggers JavaScript 
garbage collection. If the Service Manager native heap usage has increased by the specified number of 
megabytes since the last JavaScript garbage collection,  JavaScript garbage collection is triggered, and 
the native heap memory referenced by the recycled JavaScript objects is therefore freed. The minimum 
value for this parameter is 2 megabytes.

Caution: Be cautious when changing this parameter from the default value. Setting this parameter 
to a large value may result in "out of memory" errors.

Valid if set from

Initialization file (sm.ini)

Requires restart of the Service Manager server?

Yes

Default value

10 megabytes

Possible values

No less than 2 megabytes

Example usage

Initialization file: gcthreshold:5
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Web parameter: customize-folder
Web parameters change the behavior of the web clients that connect to the web tier. You can set some 
of these parameters from the web client login URL, some from the web tier configuration file (web.xml), 
and some from both.

Parameter

customize-folder

Description

This parameter specifies the absolute path to a folder on the web tier host in which your web client 
branding files are stored. You must have write access to this directory to rebrand the web client. You 
need to place your branding image files in this folder; when you perform branding in the branding 
interface, Service Manager saves your branding settings in a branding.xml file and a branding-images 
subfolder under this folder.

Caution: This parameter is required to enable the branding interface. If it is not specified, when 
you click Tailoring > Branding, the branding interface is not launched and an error displays 
instead.

Valid if set from

Web tier configuration file (web.xml)

Requires restart of the web applications server?

Yes

Default value

Empty

Possible values

An absolute directory location

Example usage

<context-param>
      <param-name>customize-folder</param-name>
      <param-value>C:/customize</param-value>
    </context-param> 

Web parameter: enableRecordlistOddEvenRowStyle
Web parameters change the behavior of the web clients that connect to the web tier. You can set some 
of these parameters from the web client login URL, some from the web tier configuration file (web.xml), 
and some from both.
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Parameter

enableRecordlistOddEvenRowStyle

Description

This parameter indicates if the odd and even rows in the record list have different background color. 

Valid if set from

Web tier configuration file (web.xml)

Requires restart of the web applications server?

Yes

Default value

false

Note: The default value means that the odd and even rows in the record list have the same 
background color. 

Possible values

true or false

Example usage

<context-param>
 <param-name>enableRecordlistOddEvenRowStyle</param-name>
 <param-value>false</param-value>
</context-param>   

Web parameter: autoCompleteDelayTime
Web parameters change the behavior of the web clients that connect to the web tier. You can set some 
of these parameters from the web client login URL, some from the web tier configuration file (web.xml), 
and some from both.

Parameter

autoCompleteDelayTime

Description

This parameter defines the delay time in milliseconds to trigger the auto complete feature after you stop 
typing characters in a Comfill field.

Valid if set from

Web tier configuration file (web.xml)

Requires restart of the web application server?

Yes
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Default value

200

Possible values

0 to unlimited

Note: If you specify an invalid value, the default value is used.

Example usage

<context-param>
      <param-name>autoCompleteDelayTime</param-name>
      <param-value>200</param-value>
    </context-param>     

Web parameter: autoCompleteListSize
Web parameters change the behavior of the web clients that connect to the web tier. You can set some 
of these parameters from the web client login URL, some from the web tier configuration file (web.xml), 
and some from both.

Parameter

autoCompleteListSize

Description

This parameter defines the maximum number of records that are fetched from the server side at one 
time and returned to an auto complete selection list. If the total number of matching records is larger 
than this specified list size, a More icon displays at the bottom of the list. Clicking this icon will load 
more records to the list. 

For example, if this parameter is set to 10 (default) and the total number of matching records is 100, the 
auto complete selection list displays 10 matching records initially with a More icon the bottom. If you 
click the More icon, another 10 records are loaded to the list. Clicking More repeatedly will load the rest 
of the records.

Valid if set from

Web tier configuration file (web.xml)

Requires restart of the web application server?

Yes

Default value

10

Possible values

1 to 100
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Note: If you specify an invalid value, the default value is used.

Example usage

<context-param>
      <param-name>autoCompleteListSize</param-name>
      <param-value>10</param-value>
    </context-param>     

Web parameter: autoCompleteMinChars
Web parameters change the behavior of the web clients that connect to the web tier. You can set some 
of these parameters from the web client login URL, some from the web tier configuration file (web.xml), 
and some from both.

Parameter

autoCompleteMinChars

Description

This parameter defines the minimum number of characters you must type in a Comfill widget to trigger 
the auto complete feature.

Valid if set from

Web tier configuration file (web.xml)

Requires restart of the web application server?

Yes

Default value

3

Possible values

1 or greater

Note: If you specify a value of zero or a negative number, the default value is used. 

Example usage

<context-param>
      <param-name>autoCompleteMinChars</param-name>
      <param-value>3</param-value>
    </context-param>     
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Web parameter: autoCompleteSkipCachingChar
Web parameters change the behavior of the web clients that connect to the web tier. You can set some 
of these parameters from the web client login URL, some from the web tier configuration file (web.xml), 
and some from both.

Parameter

autoCompleteSkipCachingChar

Description

A Comfill field’s link record may define query expressions that split the Comfill field's values to multiple 
levels, using a special character (such as a “/”) as the separator. In this case, you must specify the 
separator in this parameter, so that  the Auto Complete feature returns the same query results as the 
Fill operation when the user input contains this separator character. 

The following table shows an example of such Comfill fields.

Comfill 
field Field value

Level 0 value 
(Company)

Level 1 value 
(Location) Separator

Location

 

advantage/Africa advantage Africa /

advantage/Asia advantage Asia /

In this example, the Link record of the Location field uses the following expressions, where “/” is used 
as a separator:

$find.skip=true

if (index("/", location.full.name in $File)=0) then 
($ln.query="location.full.name#\""+location.full.name in 
$File+"\"";$ln.query=nullsub($ln.query, "true")+" and level=0")

if (index("/", location.full.name in $File)>0) then ($L.tempx=0;for $L.ix = 1 to 
lng(location.full.name in $File) do (if (substr(location.full.name in $File, $L.ix, 
1)="/") then $L.tempx+=1);$ln.query="location.full.name#location.full.name in $File 
and level="+$L.tempx)

Note: If the Link records of your Comfill fields use a different character as the separator, set this 
parameter to that character (for example, “|”). This is a global setting, which means all Comfill 
fields that have Auto Complete enabled have to use the same separator. 

If a Comfill field allows  values that contain the specified character (for example, “E-mail / Webmail 
(Africa)”), but its Link record does not use the specified character in its query expressions, Auto 
Complete will retrieve the correct query results no matter whether the user input contains the 
specified character or not.

Valid if set from

Web tier configuration file (web.xml)
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Requires restart of the web applications server?

Yes

Default value

/ (forward slash)

Possible values

Any ASCII character

Example usage

<context-param>
      <param-name>autoCompleteSkipCachingChar</param-name>
      <param-value>/</param-value>
    </context-param>     

Web parameter: comfillAutoComplete
Web parameters change the behavior of the web clients that connect to the web tier. You can set some 
of these parameters from the web client login URL, some from the web tier configuration file (web.xml), 
and some from both.

Parameter

comfillAutoComplete

Description

This parameter enables auto complete for the Comfill control. If you want to disable auto complete 
globally in Service Manager, set it to false.

To enable auto complete for a specific Comfill field, you must further enable the Auto Complete 
property of this Comfill control in Forms Designer. If this property is disabled, auto complete is disabled 
for this Comfill field regardless of the global comfillAutoComplete setting. 

Valid if set from

Web tier configuration file (web.xml)

Requires restart of the web application server?

Yes

Default value

true

Possible values

true (enabled)

false (disabled)

Example usage
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<context-param>
      <param-name>comfillAutoComplete</param-name>
      <param-value>true</param-value>
    </context-param>    

Web parameter: message display properties
Web parameters change the behavior of the web clients that connect to the web tier. You can set some 
of these parameters from the web client login URL, some from the web tier configuration file (web.xml), 
and some from both.

Parameters

messageBarError

messageBarInfo

messageBarWarning

Description

These parameters indicate how different types of messages are displayed. The parameter value 
consists of three parts: the first part defines if this  type of message is displayed in the message bar, the 
second part defines if the message automatically disappears, and the third part defines the duration in 
seconds before the message disappears. 

The latter part of the parameter value is dependent on the previous part. For example, if the first part of 
value is set as false, which means that this type of message is not displayed on the top of the detail 
window, then the following two parts of parameter values are meaningless and thus ignored. If the 
second part is set as false, which means that this type of message does not automatically disappear, 
then the last value defining the duration before the message disappears is ignored. 

Valid if set from

Web tier configuration file (web.xml)

Requires restart of the web applications server?

Yes

Default value

messageBarError true:false

messageBarInfo true:true:4

messageBarWarning true:true:6

Possible values

true (displayed)/false (not displayed): true (disappear automatically)/false (not disappear): 0 to unlimited 

Note: If you specify an invalid number for the third part of the value, a default value of 6 seconds is 
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used.

Example usage

 l <context-param>
 <param-name>messageBarError</param-name>
      <param-value>true:false</param-value>
    </context-param>     

The default value means that the error type of message is displayed on the top of the detail window, 
and does not automatically disappear.

Note: If the user changes the second value to true to make the error message bar 
automatically disappear, then the user has to set the last value to decide the duration before it 
disappears.

 l <context-param>
      <param-name>messageBarInfo</param-name>
      <param-value>true:true:4</param-value>
    </context-param>     

The default value means that the information type of message is displayed on the top of the detail 
window,  and it automatically disappears after four seconds.

 l <context-param>
      <param-name>messageBarWarning</param-name>
      <param-value>true:true:6</param-value>
    </context-param>     

The default value means that the warning type of message is displayed on the top of the detail 
window,  and it automatically disappears after six seconds.

Web parameter: startDayOfWeek
Web parameters change the behavior of the web clients that connect to the web tier. You can set some 
of these parameters from the web client login URL, some from the web tier configuration file (web.xml), 
and some from both.

Parameter

startDayOfWeek

Description

This parameter defines the first day of the week in the date picker. However, if you configure the First 
Day of Week field in the Login Profiles for an operator, then this parameter is not used for that user. 
For more information, see "Set the first day of week for an operator" on page 1.

Valid if set from
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Web tier configuration file (web.xml)

Requires restart of the web applications server?

Yes

Default value

0

Possible values

0 (Sunday)
1 (Monday)
2 (Tuesday)
3 (Wednesday)
4 (Thursday)
5 (Friday)
6 (Saturday)

Example usage

<context-param>
 <param-name>startDayOfWeek</param-name>
 <param-value>0</param-value>
</context-param>

Web parameter: compactLayout
Web parameters change the behavior of the web clients that connect to the web tier. You can set some 
of these parameters from the web client login URL, some from the web tier configuration file (web.xml), 
and some from both.

Parameter

compactLayout

Description

This parameter enables the compact layout of the web client. 

Service Manager 9.34 introduces the new user interface (UI) style, and the sizes of some UI elements 
are bigger than those of prior versions of Service Manager, for example, the height of the text widget, 
the vertical space between two adjacent widgets, and so on. The out-of-box forms have been adjusted 
to match the new size. However,  there is a possibility that the new size may cause some display 
issues in your tailored forms, for example, truncated text or overlapped UI elements.

You can use the compact layout of the web client to fix these display issues. When you enable the 
compact layout, the web client uses the same sizes as that of Service Manager 9.33, so the display 
issues caused by new sizes will disappear.

Note: HP recommends that you use the compact layout of the web client in the following 
scenarios:
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 l Your forms have display issues caused by new sizes.

 l You cannot easily change the impacted forms to solve the display issues.

Valid if set from

Web tier configuration file (web.xml)

Requires restart of the web applications server?

Yes

Default value

false

Possible values

true (Enabled)

false (Disabled)

Example usage

<context-param>
 <param-name>compactLayout</param-name>
 <param-value>false</param-value>
</context-param>

New text strings to be localized
This release has introduced a number of new text strings, all of which have been localized except for a 
few as listed in the following table. You can easily localize them using the native2ascii tool. For detailed 
localization instructions, see knowledge article KM00779834.

The following table lists the text string added in this release, as well as the corresponding properties file 
in the Windows client.

New text strings Description 

cpee_format.properties:

Props.UseStandardsMode=Standards 
Mode

The Standards Mode property of the HTML Viewer 
control

Certifications
HP Service Manager (SM) 9.34 includes the following certification changes.
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Added support
Support has been added for the following items.

Service Manager server

 l Solaris 11.1

 l Red Hat Enterprise Linux 6.5 (x86-64)

 l Oracle Enterprise Linux 6.5 (x86-64)

 l VMWare ESXi 5.5

Windows client

 l Windows 8.1

Web client

 l Internet Explorer (IE) 11 (rendering in IE 10 standards mode)

Service Request Catalog

 l Internet Explorer (IE) 11

 l IIS 7.5, 7.0

Discontinued support
Support for the following item has been discontinued.

 l Oracle 11.1 

HP strongly recommends the use of the Oracle 11R2 (Oracle 11.2.0.3 or later) and avoiding the use 
of Oracle 11R1. Our experience has shown numerous problems with the Oracle 11.1 release 
including both stability and performance that are improved in the Oracle 11.2 release and cannot be 
mitigated by changes in the Service Manager code base.

Upgrade Documentation Center
The Service Manager 9.34 Upgrade Documentation Center provides guidelines on upgrading the 
Service Manager binaries, applications, and other components (KM Search Engine, language packs, 
content packs, Service Request Catalog, Mobility, etc) to version 9.34. Available as a ZIP file on the 
HP Software Manuals Site. 
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To use this documentation center, extract the ZIP file to a local or shared drive, and then open 
default.htm in a web browser (Firefox or Chrome is recommended because certain links do not work 
in Internet Explorer unless you deploy the documentation center on a web server).

This documentation center provides a central place for quick access to the following documents (which 
are also available on the HP Software Manuals Site to download as separate documents):

 l Interactive Installation Guide (Interactive HTML)

 l Applications Upgrade Guide (PDF)

 l Applications Upgrade Guide (Interactive HTML)

 l Upgrade Assessment Toolkit User Guide  (PDF)

 l Applications Patch Manager Guide (PDF)

 l Language Pack Installation Guide (PDF)

 l Knowledge Management Search Engine Guide (PDF)

 l Mobile Applications User Guide (PDF) 

 l Service Request Catalog Interactive Installation Guide (Interactive HTML)

 l Service Request Catalog Customization Guide (PDF)

Open source and third-party redistributables package
In this release, the Applications, Web tier, and Applications Upgrade packages contain a compressed 
file, sm9.34.0032_Redistributables.zip. This zip file contains all open-source and third-party source 
code used in this release, as well as their associated license agreement files.

Note: The content of this .zip file is an updated version of that in the Redistributables folder on the 
Service Manager 9.30 installation media.

For a complete list of open source and third-party acknowledgments, see the Open Source and Third-
Party Software License Agreements manual (in PDF format) for Service Manager 9.34, which is 
available from the following HP Software Manuals website:

http://h20230.www2.hp.com/selfsolve/manuals
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Enhancements
This release includes the following enhancement type fixes.

Applications
CR Problem Solution

QCCR1E59191 The benchmark utility is no longer maintained and does not 
function correctly.

The benchmark utility is removed.

QCCR1E74070 The Affected Service field in an Interaction is not filled after 
you add it in SRC. However, the Affected Service field is 
filled in the corresponding Incident.

The affected service is added to the interaction when you 
create an incident or change for a support item.

QCCR1E99765 Support-type categories and items can be accessed through 
SRC only. However, in prior releases, these items could be 
accessed through the Employee Self-Service (ESS) portal, 
which is no longer possible.

Non-cart/support items are supported in the ESS portal.

QCCR1E101036 Service Catalog does not provide a utility to bulk load data in 
the same manner as other modules in Service Manager. As a 
result, catalog data must be loaded manually through the 
Service Catalog UI, which can take anywhere between 5 to 
10 minutes per catalog item, or by leveraging proprietary 
utilities.

The enhanced Text Import Wizard provides you with a data 
mapping function that helps you to prepare data for 
migration to Service Manager. It includes a data 
manipulation function to help you change data and make 
logical calculations within Service Manager.
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CR Problem Solution

QCCR1E102502 After you import Knowledge Management demonstration 
data by using the Knowledge Management import tool, 
Knowledge Management attachments are added 
unexpectedly.

After you import Knowledge Management demonstration 
data by using the Knowledge Management import tool, no 
Knowledge Management attachments are added 
unexpectedly.

QCCR1E103581 The auto complete feature is not supported by the web client. The auto complete feature is now supported by the web 
client. 

QCCR1E104896 When you upgrade Service Manager from earlier 9.3x 
versions, Renamed RAD applications are not automatically 
merged and you cannot manually merge them easily.

A Merge option is available for Renamed RAD applications. 
This option enables you to automatically replace your 
tailored RAD application with the new one.To use this 
option, perform the following steps:

 1. Navigate to System Administration > Ongoing 
Maintenance > Patch Release > View/Merge 
Results.

 2. Locate a Renamed RAD application through a search.

 3. Click More or the More Actions icon and select 
Merge. Service Manager will automatically create a 
backup of the old object by renaming it 
"OLD9.3x.xxxx" and then rename the new object by 
removing the prefix "NEW9.3x.xxxx" from the object 
name. The result is then marked as "Reconciled."

Note: The option does not work if the Process 
Designer content pack is installed.

QCCR1E106292 Currently, the globallist and locallist files are not cached. 
This causes heavy database traffic during the login process, 
especially when the globalist or locallist file is large.

The globallist and locallist files are added to the Service 
Manager cache.
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Documentation
CR Problem Solution

QCCR1E62332 The increasing complexity of rebranding the 
webtier is not reflected in the Service 
Manager support documentation.

Documentation about the rebranding process has been added to the Service 
Manager online help; and a white paper (KM01029433) has also been created 
to provide more detailed step-by-step instructions.

Integrations
CR Problem Solution

QCCR1E64751 The SMOMi integration template 
only allows a single OMi server 
instance.

The SMOMi integration template is enhanced to support more than one OMi server 
instances. A new parameter (omi.mgr.id) is introduced for this purpose.

Note: If you have only one OMi server instance, this parameter is not required, You 
can either configure it or simply remove the parameter and its value from your 
integration instance configuration.

QCCR1E101995 The survey API connector is 
only able to integrate with 
Market Tools.

A new API connector is added that enables support for survey solutions from Medallia, a 
new HP partner.
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Mobility
CR Problem Solution

QCCR1E104858 Android 4.x is not certified for the Service Manager Mobility 
client.

Android 4.x is certified for the Service Manager Mobility 
client.

Service Request Catalog (SRC)
CR Problem Solution

QCCR1E84503 Service Request Catalog does not support Internet Information Services 7 as a web 
server.

Service Request Catalog 9.34 now 
supports Internet Information 
Services 7 as a web server.

QCCR1E90210 The SRC client does not require the user to click Details to see item options when a 
Service Catalog item does not have required fields.

The Next button for each section of 
the request form is removed. All of 
the sections are simply expanded so 
that item options will always be 
displayed, whether they are required 
fields or not.

QCCR1E90959 When you request an item in SRC1.40, all of the sections that contain mandatory 
fields must be completed before you can edit any section that is already completed. 
For example, you have a request that has 7 sections, some of which contain 
mandatory fields. If you complete section 1 and then section 2 and then decide to 
change a response in section 2, you cannot do so until you have completed all 
mandatory fields in all sections.

The Next button for each section of 
the request form is removed. All of 
the sections are now simply 
expanded. You can edit any section 
instead of being limited to editing 
them one by one.
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CR Problem Solution

QCCR1E91531 Users may not notice that a bundle in SRC 1.4 contains optional components. The 
optional components appear green (ready to go), and the user must click Edit to see 
that a checkbox is available to select the component.

The Next button for each section of 
the request form is removed. All the 
sections are simply expanded so 
that users do not miss optional 
sections easily.

QCCR1E94696 When an operator record is set to “Expire Password”, the operator should change 
their password when they next log in to Service Manager or SRC. However, in SRC 
there is no password reset screen, and the operator can still log into SRC 
successfully without changing their password.

Users can now reset their password 
directly from SRC.

QCCR1E97224 To update a single field in a request form (for example, a request description), you 
must move through all sections of the form by clicking the Next button.

The Next button for each section of 
the request form is removed. Now, 
you can expand each section of the 
form, which enables you to update 
any field without moving through all 
of the sections.

QCCR1E103717 When you update a ticket in SRC, you must fill or scroll through all of the fields, 
whether you want to update that field or not. For example, if you need to add an 
attachment to an existing ticket from SRC, after you click the update button, you 
must navigate through all of the fields to add the attachment. You cannot go directly 
to the Attachments section.

The Next button for each section of 
the request form is removed. All of 
the sections are now simply 
expanded. Now, you can update any 
field without browsing through all of 
them.

QCCR1E104854 Internet Explorer 11 is not certified for SRC. Internet Explorer 11 is certified for 
SRC.

QCCR1E104855 The latest version of Firefox is not certified for SRC. The latest version of Firefox is 
certified for SRC.

QCCR1E104856 The latest version of Chrome is not certified for SRC. The latest version of Chrome is 
certified for SRC.
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CR Problem Solution

QCCR1E106554 SRC 9.32 uses different fonts (HPSimplified TTF) to SRC 1.4 (Collator and Gotham 
OTF). There is no way to opt-out of this change or to customize it (excluding 
customizing the header and footer region by using the style.swf style).

Fonts in SRC are now 
customizable.

QCCR1E107635 When a section in SRC contains only read-only fields, the Edit button is still visible. The Edit button is removed from the 
new UI of the request form in SRC.

QCCR1E107793 Service Request Catalog does not support Internet Information Services 7.5 (IIS7.5)  
as a web server.

Service Request Catalog 9.34 now 
supports IIS7.5.

QCCR1E109767 Android 4.x is not certified for SRC Tablet. Android 4.x is certified for SRC 
Tablet 9.34.

Server
CR Problem Solution

QCCR1E94696 When an operator record is set to 
“Expire Password”, the operator 
should change their password when 
they next log in to Service Manager or 
SRC. However, in SRC there is no 
password reset screen, and the 
operator can still log into SRC 
successfully without changing their 
password.

Users can now reset their password directly from SRC.
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CR Problem Solution

QCCR1E96888 Service Manager should log the 
hostname or IP address of the web 
service requester host in the sm.log 
file when a SOAP request is received.

When there is no hardware load balancer or proxy between the web service client 
tool (for example, SOAPUI) and Service Manager, the IP address of the web 
service requester host is now written to the Service Manager server log (sm.log). If 
there a hardware load balancer or proxy is present, you must include http header 
"CLIENT_IP" and the web service client IP address as its value in the web service 
request before the host IP address can be written to the server log. However, if the 
Forwarded-For header setting is enabled on your hardware load balancer, there is 
no need to include this header.

QCCR1E98995 Oracle Solaris Server 11.1 is not 
certified for Service Manager.

Oracle Solaris Server 11.1 is certified for Service Manager.

QCCR1E100478 Windows Server 2012 R2 is not 
certified for the Service Manager 
server.

Windows Server 2012 R2 and Windows Server 2012 R2 Hyper-V are certified for 
the Service Manager server.

QCCR1E101012 When Service Manager creates a 
JavaScript host object, Service 
Manager initializes the object from the 
beginning. This process takes a lot of 
time.

The performance of the JavaScript engine is improved.

QCCR1E102306 Service Manager does not support 
cookie authentication.

The 8th parameter (<Response headers>) of "doHTTPRequest" is created to 
enable cookie authentication in Service Manager.

QCCR1E104619 Service Manager does not support 
Oracle Solaris Server 11.1 for the 
Knowledge Management search 
engine.

Service Manager supports Oracle Solaris Server 11.1 for the Knowledge 
Management search engine.

QCCR1E105727 Service Manager does not support 
VMWare ESXi 5.5.

VMWare ESXi 5.5 is certified for Service Manager.
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CR Problem Solution

QCCR1E106292 Currently, the globallist and locallist 
files are not cached. This causes 
heavy database traffic during the login 
process, especially when the globalist 
or locallist file is large.

The globallist and locallist files are added to the Service Manager cache.

QCCR1E106302 The shared_memory parameter can 
be configured to a very small value, 
which causes problems.

If you configure the shared memory to less than 128 MB, a warning message is 
logged in the Service Manager server log (sm.log). To remove this warning, set the 
"shared_memory" parameter to be 128MB or greater.

Note: On Linux/UNIX, after you increase this value, the Service Manager 
server may fail to start with the following messages: 

522( 2522) 03/26/2014 15:33:45 RTE W Shared memory size of 32000000 
too small, adjusted to 134217728 2522( 2522) 03/26/2014 15:33:45 RTE E 
sm_init: shmget( 0x784DFB00, 134217728 ) failed, errno=22 (Invalid 
argument) 2522( 2522) 03/26/2014 15:33:45 RTE E sm_init: shared 
memory kernel parameters may not be sufficient 2522( 2522) 03/26/2014 
15:33:45 RTE E HP Service Manager is unable to start. Failed to 
initialize or attach to shared memory environment 2522( 2522) 
03/26/2014 15:33:45 RTE E Could not create shared memory

In this case, you should adjust the kernel parameter for shared memory size 
limit as root.

QCCR1E107392 Service Manager does not support 
RHEL 6.5.

Service Manager supports RHEL 6.5.

QCCR1E107393 Service Manager 9.3x does not 
support Oracle Linux 6.5 (64-bit).

Service Manager 9.3x supports Oracle Linux 6.5 (64-bit).
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Upgrade
CR Problem Solution

QCCR1E77941 The Service Manager Upgrade Assessment Toolkit is not certified to 
support 32-bit versions of JRE7.

The Service Manager Upgrade Assessment 
Toolkit is certified to support 32-bit versions of 
JRE7.

QCCR1E103653 After you upgrade Service Manager, you receive an "Upgrade is complete" 
message. However, this is not enough information for first-time users, who 
may forget to perform conflict resolution or to create a custom upgrade.

The dialogs that appear after you upgrade 
Service manager are updated. Different 
messages are displayed for out-of-box 
upgrades and custom upgrades have been 
updated, both containing detailed steps to 
follow.

QCCR1E103704 The Service Manager Upgrade Assessment Toolkit is not certified to 
support 64-bit versions of Windows.

The Service Manager Upgrade Assessment 
Toolkit is certified to support 64-bit versions of 
Windows.
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QCCR1E103901 When you upgrade Service Manager, it is not easy to merge existing RAD 
applications if they conflict with the upgraded version. You may not have a 
license to modify RAD applications, or you may not want to modify RAD 
applications again and may prefer to retain your modified versions. There 
is no way to directly replace RAD applications when you apply the out-of-
box upgrade in Replace mode. When you use Replace mode, all old 
records are replaced.

A form that allows the user to select whether 
or not to replace RAD applications when they 
have a conflict with the upgrade version is 
added to the Upgrade wizard. 

When you select the Replace RAD option in 
the wizard, each renamed RAD application is 
replaced with the upgraded version, and a 
copy of the old RAD application is renamed to 
"PRE<version_number+RAD name>". The 
upgrade result for this RAD application is 
"Replaced." 

When you do not select the Replace RAD 
option in the wizard, renamed RAD 
applications are not replaced, but still remain 
in the Renamed list. The upgraded version of 
the RAD application is renamed to 
"NEW934<RAD name>". The upgrade result 
for this RAD application is "Renamed."

QCCR1E103904 High Level reports only display a tailoring status icon 
(normal/warning/error) for each table. Therefore, you do not know how 
many added, modified, or deleted objects are in the current system, 
compared to the selected out-of-box base version system.

The showdetail parameter is added to the 
reports.xml file. When the value of the 
parameter is "true," the High Level report 
displays how many added, modified, or 
deleted objects are in the current system 
compared to selected out-of-box base version 
system.

QCCR1E103905 You cannot create a Customized Records report that displays the unique 
key value of each added, deleted, or modified record only. Therefore, the 
content of reports may contain too much detail, and the report may take a 
long time to generate.

You can now configure the default 
Customized Records report to display the 
unique key value of each added, deleted, or 
modified record only.
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QCCR1E104225 There is no tool to transfer delta data from one Service Manager system to 
another.

The Delta Migration Tool is now available to 
transfer delta data from one Service Manager 
system to another.

QCCR1E104494 There is no option to merge or revert "Application Cluster" objects. The following options are added to enable you 
to merge or revert Renamed/Kept Customer 
"Application Cluster" objects:

 l (Mass) Choose Upgrade

 l (Mass) Revert

QCCR1E104625 The upgrade log needs to be improved. The Upgrade log is enhanced as follows:

 l There is phase information in both the 
"upgrade.log" and "detail.log" files.

 l All content in the "upgrade.log" file is now 
included in the "detail.log" file.

 l The Client Process ID in the log file is 
removed.

 l The unique ID and signature numbers (the 
current, OOB and upgrade) of the upgraded 
object are recorded in the "detail.log" file.

 l The timestamp in each log message now 
uses the ISO standard format (for 
example, 2014-10-10 00:00:00).

 l When you create a customer upgrade, all 
content in the "transfer.log" file is now 
included in the "detail.log" file.
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QCCR1E105351 You cannot delete OLDSM objects (for example RAD applications) after 
you run an applications custom upgrade.

Once the applications custom upgrade is 
complete, OLD objects are moved to their 
corresponding revision tables. You can view 
an old object from the More or More Actions 
menu of the new object (More > Revison > 
View Revisions). You no longer need to 
delete them.

QCCR1E105484 There is no Choose Upgrade option for individual Renamed upgrade 
result objects.

A Choose Upgrade option is added for each 
Renamed upgrade result object.

QCCR1E105539 When you merge RAD applications after you upgrade Service Manager, 
the operation fails with an error. However, after you log in again, the RAD 
applications merge with no error.

After the upgrade, you are automatically 
logged out when you click the OK button on 
the "UPGRADE IS COMPLETE" dialog box.

QCCR1E106423 Only the following two messages are recorded in the upgrade log files 
when transfer.bin is loaded:

Checking sqlsystemtables records and remapping tables…

 Finished checking sqlsystemtables records and remapping tables.

More meaningful logs, including phase 
information, are added to the upgrade.log and 
detail.log files when transfer.bin is loaded.

QCCR1E106764 Some tailored objects and normal "Kept Customer" objects are mixed up 
during an applications upgrade.

The applications upgrade process now marks 
tailored records that are added by customers 
as "Kept Customer Non-OOB."

QCCR1E107694 High Level reports only display Yes/No flags for Overall Assessment and 
RDBMS Detailed Assessment.

High Level reports now display more detailed 
information about for Overall Assessment and 
RDBMS Detailed Assessment.
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Web client
CR Problem Solution

QCCR1E30474 The first day of the week in the date picker is set to Sunday, 
and cannot be configured.

The first day of the week can now be configured in the 
operator's Login Profiles (Start Day of Week) or in the 
startDayOfWeek parameter in the web tier configuration file 
(web.xml). 

Note: The operator's Start Day of Week setting if 
present takes precedence over the global 
startDayOfWeek setting in the web tier configuration 
file (default: 0, which represents Sunday).

For more information, see "Web parameter: 
startDayOfWeek" on page 47.

QCCR1E101320 Internet Explorer 11 is not certified for the web client. Internet Explorer 11 is certified for the web client.

QCCR1E103581 The auto complete feature is not supported by the web client. The auto complete feature is now supported by the web 
client.

QCCR1E104847 The latest version of Chrome is not certified for the Service 
Manager web client.

The latest version of Chrome is certified for the Service 
Manager web client.

QCCR1E104849 The latest version of Firefox is not certified for the Service 
Manager web client.

The latest version of Firefox is certified for the Service 
Manager web client.

QCCR1E110037 When you type any characters into a Comfill widget, the 
suggested values do not automatically appear below the 
widget. Instead, you must click the Fill button or make the 
Comfill a Combo in order to show all the suggested values.

Now when you type any characters into a Comfill widget, 
the suggested values automatically appear below it as a 
drop-down list. You can still click the Fill button or make the 
Comfill a Combo to show all suggested values.
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Windows client
CR Problem Solution

QCCR1E100477 Windows 8.1 is not certified for the Service Manager 
Windows client.

Windows 8.1 is now certified for the Service Manager 
Windows client.
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Fixed defects
This release fixes the following defects.

Applications
CR Problem Solution

QCCR1E78488 When you manually close an incident that is open-linked to an interaction, a 
linker class schedule record is generated to auto-close the related interaction in 
the background. However, the interaction that is closed by the linker 
background process only intermittently invokes the SD.update.interaction 
formatctrl validation.

Now, an interaction that is closed by the 
linker background process invokes the 
master formatctrl validation that is 
specified in the incidents objects 
definition.

QCCR1E99009 In Service Manager 9.31, locking mechanisms were moved from JavaGroups 
and into the RDBMS. This causes high I/O and CPU loads.

The locking mechanism is improved for 
background processes.

QCCR1E99749 The performance of the RESTful API does not improve as expected in a 
vertically scaled environment.

The performance of the RESTful API 
improves as expected in a vertically 
scaled environment.

QCCR1E100497 The Change ID number increases when you withdraw a change. The Change ID number does not 
increase when you withdraw a change.

QCCR1E100525 The Expiration time and Breached fields are not displayed in the catalog item 
section of an interaction when you select Order from catalog.

The Expiration time and Breached fields 
are displayed as expected.
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QCCR1E100626 Errors occur when you load the SMReportsDependency_1.00.unl file two 
times.

Errors do not occur when you load the 
SMReportsDependency_1.00.unl file 
two times.

QCCR1E100873 When you add a new line item to a pending quote, the Sequence number 
(instead of the part number) is displayed in the "#" column.

When you add a new line item to a 
pending quote, the part number is 
displayed in the "#" column as expected.

QCCR1E101187 Service Desk approvals are not processed consistently when you submit and 
resubmit the approvals.

The behavior when you submit and 
resubmit Service Desk approvals is now 
consistent.

QCCR1E101174 The RuleWizardHelpers.getRecipientList ScriptLibrary causes too many 
database calls.

The performance of the 
RuleWizardHelpers.getRecipientList 
ScriptLibrary is improved.

QCCR1E101184 The login process takes an excessive amount of time. The performance of 
KMSecurity.getCatsAtLogin is 
improved to speed up the login process.

QCCR1E101237 When you click Tailoring > Differential Upgrade > Patch Records, an error 
occurs and no record is displayed.

When you click Tailoring > Differential 
Upgrade > Patch Records, the patch 
records are displayed as expected.

QCCR1E101238 When you create a cart item by using webservices, you experience a high 
response time.

The response time when you create a 
cart item by using webservices is 
improved.
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QCCR1E101304 When you use the keyboard to select a row in the Categories table in a 
Knowledge Document, and then invoke the Remove button, the selected 
category is not removed. However, you can remove a category item by using 
the mouse.

Now you can use the keyboard as well 
as the mouse to remove an item from the 
Categories table in a Knowledge 
Document.

Prerequisite: You must move the "Add" 
and "Remove" buttons to the right of the 
table in the form in Forms Designer. 
Therefore, when you tab out of the table, 
the related buttons receive the focus 
first.

QCCR1E102366 When you order a catalog item that is configured to use the "Open New 
Request" connector, the interaction is created with a related quote. When the 
quote is closed, users receive a message that says the quote has a related 
interaction and asks whether the user wants to force the closure. If the users 
choose "No," the quote is closed but the interaction is also closed 
unexpectedly.

If the users choose "No," the quote is 
closed but the interaction remains open.

QCCR1E102867 When you review a change in the ToDo list, and then click Back, you receive an 
error message.

When you review a change in the ToDo 
list, and then click Back, you do not 
receive an error message.

QCCR1E103456 When you use the "Any of these words" text search option to export records to 
Excel or to a text file, some records are not exported.

All records are exported as expected 
when you use the "Any of these words" 
text search option to export records to 
Excel or to a text file.

QCCR1E103492 Sometimes several globalists are processed as renamed although there is no 
conflict.

Globalists that build a list on startup are 
not processed as renamed if there is no 
conflict.
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QCCR1E104118 Outage events do not apply to the Affected Service (affected.item) and to the 
Affected CI (logical.name) in the same way.

Outage events now apply to the Affected 
Service (affected.item) and to the 
Affected CI (logical.name) in the same 
way.

QCCR1E104131 When you view the relationship graph for an application that has more than 1500 
downstream CIs, the web client freezes for about 90 seconds, and you receive 
the following error message:

Error: You have been logged out due to session timeout. 

In the Windows client, you receive the following error message as soon as you 
enter the CI name:

Your server session may have been terminated or timed out.

Additionally, a "Signal 11" error is generated.

You can now view a CI relationship graph 
that contains 2000 downstream CIs as 
expected.

QCCR1E104189 The Mass Approval functionality does not work if the corresponding 
ApprovalDef record refers to an Approval Group.

The Mass Approval functionality works 
as expected if the corresponding 
ApprovalDef record refers to an Approval 
Group.

QCCR1E104210 There is no KnowledgeBroker's demo data in Service Manager. KnowledgeBroker's demo data is now 
included in Service Manager.

QCCR1E104263 Every time that a Change template is modified, the system adds a closing 
quote and a squiggly bracket to the final array element in Affected CI in the 
template.

Changes to templates do not add closing 
squiggly brackets to the final array 
element.

QCCR1E104358 The web client times out when you try to display the CI Relation Graph for a CI 
that has more than 1500 downstream CIs.

The CI Relation Graph is displayed as 
expected when an CI has more than 
1500 downstream CIs.

QCCR1E104753 The Linker process locks interaction records when an update fails due to a 
policycheck call.

The lock is now released if a background 
update fails due to a policycheck call.
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QCCR1E104737 The "Export to Excel" functionality is not working as intended in the web client. The "Export to Excel" functionality now 
works as expected.

QCCR1E104768 When you pull or push data, the HTTP client automatically follows the HTTP 
redirects by default. Therefore, a "Server returned HTTP response code: 401" 
exception is recorded in the sm.log file.

Now you can set the 11th parameter 
(<Follow redirects>) of 
"doHTTPRequest" to "false" so that the 
HTTP client does not automatically 
follow the HTTP redirects.

QCCR1E105049 You cannot add affected services during certain phases (such as "Build and 
Test") in an environment that has PDCP applied.

Affected services are added according 
the CI relationship definition in an 
environment that has PDCP applied.

QCCR1E105136 A new USER_SID column was added to the SYSLOGM1 table, but the column 
is not indexed. This leads to poor performance when the column is queried.

The USER_SID column is assigned a 
"Nulls & Duplicates" key now.

QCCR1E105310 When you open a new incident, you receive the following error message:

Error: SQL code=1722 message=ORA-01722: invalid number

You receive no error message when you 
open a new incident.

QCCR1E105668 When a Fill action is performed, the value that is returned has the character 
datatype (2) instead of the expected array datatype (8). 

Fill actions that are performed on array 
fields now populate the field with an array 
datatype value.

QCCR1E106148 When you export Change records that contain multiple CI's, the CI's are added 
to the text file in separate rows.

When you export Change records that 
contain multiple CI's, the CI's are added 
to the text file in a single row.

QCCR1E106672 When you view the Affected CI list, you receive the following error message:

Error: The WHERE clause string exceeded 64k (use.link)

You are now informed to use a filter if the 
Affected CI list exceeds the limit.
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QCCR1E107454 When you send a "Create new interaction" request that does not contain a 
contact by using the SOAP UI, Format Control validation is bypassed, and the 
interaction is created.

If the formatctrl validation fails, attempts 
to create a new interaction by using the 
SOAP UI return error code "71," and the 
interaction is not created.

QCCR1E107689 The Elapsed Time field (total.time) in the sloresponse table is empty when the 
sloresponse status is suspended.

Now the total.time of the sloresponse 
table is calculated when the sloresponse 
status is suspended.

QCCR1E108371 After you cancel the creation of a new line item, the item is incorrectly added to 
the Bundle tab.

Cancelled items are not added to the 
Bundle tab.

QCCR1E108730 SLA does not add the initial state (as defined in the slamodulecontrol table) to 
the state.change array of the slaactive record. Therefore, the elapsed time in 
the sloresponse record is incorrectly displayed as "00:00:00."

SLA adds the initial state (as defined in 
the slamodulecontrol table) to the 
slaactive record and calculates the 
correct total elapsed time for the SLO.

QCCR1E109187 When you edit or add a color in calendar mapping, the color selection table 
unexpectedly displays a horizontal scroll bar.

When you edit or add a color in calendar 
mapping, the color selection table does 
not display a horizontal scroll bar.

QCCR1E109313 The Survey Administration menu is located directly under the System 
Administration menu.

The Survey Administration menu is 
moved to the System Administration > 
Ongoing Maintenance submenu.
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QCCR1E111692 An error that resembles the following occurs when applying a Service Manager 
9.3x Application patch:

3156( 1648) 06/29/2014 20:53:38 RAD E Unable to open file

/sm7test/ServiceManager9.3/CustomUpgrade/detail.log for writing

3156( 1648) 06/29/2014 20:53:38 RTE I Dbdict of file (cirelationship -->

cirelationship) was updated by user falcon

3156( 1648) 06/29/2014 20:53:39 RTE I Dbdict of file (datadict --> datadict) was

updated by user falcon

3156( 1648) 06/29/2014 20:53:39 RAD E Unable to open file

/sm7test/ServiceManager9.3/CustomUpgrade/detail.log for writing

3156( 1648) 06/29/2014 20:53:39 RTE I Dbdict of file (irqueue --> irqueue) was

updated by user falcon

3156( 1648) 06/29/2014 20:53:39 RTE I Dbdict of file (datadict --> datadict) was

updated by user falcon

3156( 1648) 06/29/2014 20:53:40 RTE I Dbdict of file (svcCatInterface -->

svcCatInterface) was updated by user falcon

3156( 1648) 06/29/2014 20:53:40 RTE I Dbdict of file (datadict --> datadict) was

updated by user falcon

3156( 1648) 06/29/2014 20:53:40 RTE I Dbdict of file (svcItemCount -->

svcItemCount) was updated by user falcon

3156( 1648) 06/29/2014 20:53:40 RTE I Dbdict of file (datadict --> datadict) was

The error no longer occurs when applying 
a Service Manager 9.3x Applications 
patch.
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updated by user falcon

3156( 1648) 06/29/2014 20:53:41 RAD E Unable to open file

/sm7test/ServiceManager9.3/CustomUpgrade/detail.log for writing

QCCR1E111831 A newly added dbdict and its records may fail to be loaded using Unload 
Manager.

A newly added dbdict and its records are 
successfully loaded using Unload 
Manager.

Documentation
CR Problem Solution

QCCR1E103694 You cannot input decimal numbers with a fractional 
part in Service Manager that is installed on a Linux 
system with a locale such as de_DE.utf8, or fr_
FR.utf8.

The following note is added to the "Parameter: 
localizedecimalpoint" topic in the 
online help:

Caution: When the Service Manager server is running on a Linux 
host, set the locale to en_US.utf8. If you use other locale settings 
such as de_DE.utf8 or fr_FR.utf8, it is not possible to assign a 
number with decimal places to a variable in RAD expressions or 
JavaScript. If you try to assign something like "x 
$fag.number=1.456" in RAD Debugger, the result is 1.

QCCR1E104308 The Service Manager Language Pack Installation 
Guide is unclear about how to upgrade the French 
Language pack.

The Service Manager Language Pack Installation Guide is 
updated to include more specific information about how to 
upgrade the French Language pack.
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QCCR1E105162 Duplicate key errors occur when you upgrade the 
applications from SC 6.2.8 to Service Manager 9.31.

Additional steps are added to the "Remove indexes and 
constraints in the RDBMS" section of the Applications Upgrade 
Guide (in both interactive HTML and PDF formats) to prevent this 
issue.

QCCR1E105928 In the "Remove indexes and constraints in the 
RDBMS" section of the Applications Upgrade Guide, 
there is no detailed information about how to remove a 
unique key.

Detailed steps are added to the "Remove indexes and constraints 
in the RDBMS" section of the Applications Upgrade Guide (in 
both interactive HTML and PDF formats).

QCCR1E106163 The Programming document that describes the 
compilation of javascript code in triggers contains 
mistakes.

The "Trigger scripts" topic is updated.

QCCR1E106668 You cannot disable the Remember Login feature. The src.enableRememberLoginUserName parameter is added to 
enable or disable the Remember Login feature. The default value 
of this parameter is "false" 
(src.enableRememberLoginUserName=false), which disables the 
feature in the user login panel.

QCCR1E107618 When you build a custom upgrade, assignment group 
records are included in the upgrade, under control of 
the configuration information in the patches record. 

However, assignment group records (especially 
memberships) are most likely changed a lot during the 
preparation phase of the upgrade process. All changes 
to groups and memberships made during the 
preparation phase will be cancelled out when the 
Custom Upgrade is applied to the production system.

The "Troubleshooting" section of the Upgrade Guide (in both PDF 
and interactive html) is updated to include a workaround to avoid 
assignment objects from being included in the patch.
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QCCR1E109127
 

There is no information in the online help about whether 
or not Array type fields are allowed by KM Import 
Utility.

The following note is added to the following documents:

 l Online help topic: XML source document considerations for 
importing 

 l README.txt shipped with the KM Import Utility package 

"If you have tailored the kmdocument dbdict, be sure to not 
include your tailored Array fields, Structure fields, and Arrayed 
Structures fields in the source XML documents; otherwise the 
import will fail."

QCCR1E110319 The utallocmode parameter is documented incorrectly. 
It does require a server restart.

The utallocmode parameter is documented correctly.

Upgrade
CR Problem Solution
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QCCR1E103641 When you compare a renamed "Application Cluster" in the upgrade 
results after you perform an upgrade, you receive the following error 
messages:

Process panel get.xml.data in RAD run.merge.tool 
encountered error in line 1 (run.merge.tool,get.xml.data)

Cannot evaluate expression (run.merge.tool,get.xml.data) 
Bad arg(2) oper = (run.merge.tool,get.xml.data)

Cannot evaluate expression (run.merge.tool,get.xml.data) 
Script 'upgradeHelper' line 354: ERROR TypeError: 
strAncestorXml.replace is not a function at char 1 

Unable to open file F:\9.32-Release-Build-0016_GA_
sh\sm9.32.0016_Application_
Upgrade\AppUpgrade\application-9.32.0016-UP\localized_
app_upgrade\SC6.2-9.32.0016_
L10N\3waymerge\oob\SC6.2\enclapplrev\km.environment.xml 
for reading

Unrecoverable error in application: se.call.process on panel 
call.rad.1

Unrecoverable error in application: run.merge.tool on panel 
get.xml.data

No errors occur when you compare "Application 
Cluster."

QCCR1E103687 Customized fields and datatype mapping reports do not ignore the 
case sensitivity of the SQL data type.

Customized fields and datatype mapping reports now 
ignore the case sensitivity of the SQL data type.

QCCR1E103710 An internal "Java Heap Space" error occurs when you generate the 
Customized Records report.

The compareDetail and showModifyDetail 
parameters are added to report.xml to control the 
Customized Records report. Additionally, the 
maximum JVM heap size is increased. The toolkit 
now compares only the signature number of each 
record and displays the Added/Modified/Deleted 
amounts by default.
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QCCR1E104094 The SQL type of the operators field in the kmgroup table is not up-
to-date in the upgradeTableAliasChange ScriptLibrary.

The SQL type is updated to VARCHAR(80) in the 
ScriptLibrary record.

QCCR1E104095 There is an inconsistency between Upgrade Patch Utility (UP) and 
Applications Patch Manager (APM) in the patch definition.

There is no longer an inconsistency between Upgrade 
Patch Utility (UP) and Applications Patch Manager 
(APM) in the patch definition.

QCCR1E104215 Error messages that resemble the following are recorded in the 
except.log file when you upgrade the applications from version 9.20 
to version 9.32:

7 07/01/16 08:50:07 The alias of the array field 
current.pending.groups in the table Approval cannot be 
updated to upgraded version.

7 07/01/16 08:50:07 The alias of the array field related.cis in 
the table cirelationship cannot be updated to upgraded 
version.

7 07/01/16 08:50:07 The alias of the array field approvers in 
the table cm3groups cannot be updated to upgraded version.

7 07/01/16 08:50:07 The alias of the array field members in the 
table cm3groups cannot be updated to upgraded version.

7 07/01/16 08:50:07 The alias of the array field permission in 
the table kmcategory cannot be updated to upgraded version.

7 07/01/16 08:50:07 The alias of the array field operators in the 
table kmgroup cannot be updated to upgraded version.

If the correct aliases are used before the upgrade, no 
error messages about aliases are recorded in the 
except.log. Messages about aliases are recorded in 
the detail.log instead. 

QCCR1E105116 Timestamps in the upgrade logs are inconsistent. Timestamps in the upgrade logs are now consistent, 
and are formatted as follows:

yyyy-mm-dd HH:mm:ss.
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Integrations
CR Problem Solution

QCCR1E104528 When you close an unplanned change, a RAD error occurs. RAD errors do not occur when you close an 
unplanned change.

QCCR1E105553 When you search the SMISRegistry table by using the out-of-box 
default settings, only the SMOO record is returned.

All records are returned when you search the 
SMISRegistry table by using the out-of-box 
default settings.

QCCR1E108492 The value of the “processedDate” field is set inconsistently during the 
unplanned change processes for CI attribute changes and for CI 
relationships.

The “processedDate” field is left empty when you 
deny an unplanned change for a CI attribute 
change.

Localization
CR Problem Solution

QCCR1E105667 Custom language builders do not work when you use Language 
Builder to build custom language packs.

You can now use Language Builder to build custom 
language packs as expected.

QCCR1E106290 After you apply the pt-Br language pack, Wizard buttons are not 
translated.

Wizard buttons are translated when you apply the pt-
Br language pack.
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Service Request Catalog (SRC)
CR Problem Solution

QCCR1E102665 Only the first line in a multi-line field is displayed on the page. Other 
lines are displayed in the tooltip.

Text in multi-line fields is displayed in a readable 
format, with a scroll bar to enable you to view all the 
data.

QCCR1E103134 The validation tool to check the manifest.xml file is not working on 
the Windows shell because wildcard character "*" (asterisk) in the 
command script is not supported.

The wildcard character in the command script has 
been replaced with the specific version value. 

QCCR1E103274 When src.service.enablePrice is set to false in the 
applicationContext.properties file, the cost column is removed as 
expected. However, the Approve and Deny buttons are also 
removed from the approval list in the SRC 9.32 dashboard.

The Approve and Deny buttons are correctly 
displayed in the approval list.

QCCR1E103491 SRC fails to start in FIPS mode, because JCE cannot authenticate 
the provider JsafeJCE.

SRC is able to start in FIPS mode now.

QCCR1E104127 Users can submit new service requests in SRC even when you 
disable the "New" option for their user profile in the Service Manager 
server.

Users cannot submit new service requests in SRC 
when you disable the "New" option for their user 
profile in the Service Manager server.

QCCR1E104335 When you create a general SRC support request for another user, 
the Affected Service list under the Additional Info panel is not 
refreshed to display the subscription items that are available to that 
user. If you select a service item that is unavailable to the "Request 
For" user from the list, you receive an "Invalid Service" error after 
you submit the request.

When you create a general SRC Support Request 
for another user, the Affected Service list under the 
Additional Info panel is automatically refreshed to 
only display the subscription items that are available 
to that user. Therefore, you can submit the request 
successfully.
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QCCR1E104633 The Service Recipient is not set correctly in Service Manager when 
you order a Support Catalog item from Service Request Catalog on 
behalf of another user.

The Service Recipient is now set correctly in 
Service Manager when you order a Support Catalog 
item from Service Request Catalog on behalf of 
another user.

QCCR1E104867 When you select a category that does not contain any items that are 
visible to end users, an error occurs.

When you select a category that does not contain 
any items that are visible to end users, a "No items 
found" message is displayed.

QCCR1E105308 The Service Recipient is not set correctly in Service Manager when 
you order a service item in SRC Request On Behalf (ROB) mode.

The Service Recipient is set correctly in Service 
Manager when you order a service item in SRC 
Request On Behalf (ROB) mode.

QCCR1E106099 SRC does not support the ART tool to record objects. The request form is correctly recognized by the ART 
tool.

QCCR1E106278 New attachments that are added to SRC 1.26 are not displayed even 
after the multiple Catalog Refresh cycles.

New attachments that are added to SRC are 
displayed as expected.

QCCR1E106967 You cannot select or copy read-only text fields and text areas in 
Service Request Catalog 9.33.

You can select or copy read-only text fields and text 
areas as expected.

QCCR1E110952 The SRC Tablet app does not support Korean on Android 4.2.2. Korean is displayed correctly in the SRC Tablet app 
on Android 4.2.2 and above.

QCCR1E111065 The cross image displayed in the Support dashboard is not a neutral 
symbol to all users.

The cross image displayed in the Support 
dashboard is replaced with a neutral one.
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QCCR1E110280 The Email address of a contact record is not 
recognized as a valid one in Service Manager 
Mobility if it contains a dash "-" character in the 
domain name. For this reason, you cannot tap 
on it to send an Email.

The Email address of a contact record is now 
recognized as a valid one in Service Manager 
Mobility if it contains a dash "-" character in the 
domain name. You can tap on it to send an 
Email.

Server
CR Problem Solution

QCCR1E70834 The Load Balancer and background processes unexpectedly terminate in a 
horizontally scaled Service Manager 7.11 Patch 17 environment.

This "jgroups node got shunned" issue 
is solved by changing the JGROUP 
configuration.

QCCR1E71700 Service Manager performs poorly and hangs when Incidents are created or 
accessed. After a recycle, the indexes on the probsummary table are marked as 
not usable.

This issue no longer occurs.
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QCCR1E95118 After you refresh the web client, the first group in a record list is always expanded, 
and the selected record is not selected anymore.

Now, when you open a view from the 
To-Do queue, all groups in the view are 
collapsed by default. When you switch 
to a new view in the To-Do queue, all 
groups in the new view are collapsed.

If you have not manually expanded any 
group in a view, or if you have 
expanded a group without selecting a 
record, when you click the Refresh 
button, all groups in the view are 
collapsed.

If you have expanded one group and 
selected one record in the group, when 
you click the Refresh button, the 
previously selected record is still 
selected and the corresponding group 
is expanded, no matter whether the 
group of the record is changed or not.

QCCR1E98066 A RAD compilation failure causes a memory leak. There is no memory leak when a RAD 
compilation fails.
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QCCR1E99284 When you apply changes to the dbdict in various environments, they do not 
consistently map across the environments. For example, when you add a field to 
the incidents dbdict in your development environment and allow Service Manager 
to make the changes to the database, the development environment maps the 
field to a field in the INCIDENTSM1 table in the database; however, when you 
make the same modification in your acceptance environment and allow Service 
Manager to make the changes to the database, the acceptance environment 
maps the field to a field in the INCIDENTSM2 table in the database, and moves a 
field that had been on the INCIDENTSM2 table onto the INCIDENTSM1 table.

The Service Manager dbdict splits the main table into M2 and M3 across the 
environments. As a result, it is difficult to run reports against the system because 
this results in no row being selected or incorrect rows being displayed.

There needs to be the ability to control table splitting in Service Manager, or 
remove table splitting altogether.

Now the Service Manager server reads 
the row size limitation and column 
number limitation from file "sqldbinfo" 
and use the information when making a 
decision about splitting SQL tables.

Note: 

 l This fix affects SQL Server 
database servers only.

 l For MS SQL Server, if you 
want to disable table splitting, 
you need to manually set the 
row size limitation in the 
“sqldbinfo" table to a very large 
number, which is supported by 
SQLSERVER 2008 and later 
with ROW_OVERFLOW_
DATA.

 l Modifications to the "sqldbinfo" 
table require a restart of the 
Service Manager server.

The following constraints still 
exist, which you need to consider 
if you want to disable the row size 
limitation:

 l The feature of Row-Overflow 
Data Exceeding 8 KB is not 
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supported by SQL Server 
2005. For this reason, if you 
are using SQL Server 2005, do 
not change the default MAX 
ROW SIZE value in the 
“sqldbinfo" table.

 l The length of individual 
columns must still fall within 
the limit of 8,000 bytes for 
varchar, nvarchar, varbinary, 
sql_variant, and CLR user-
defined type columns. Only 
their combined lengths can 
exceed the 8,060-byte row 
limit of a table.

 l The sum of other data type 
columns, including char and 
nchar data, must fall within the 
8,060-byte row limit. Large 
object data is also exempt 
from the 8,060-byte row limit.

 l After removing the size 
limitation, if a file does have an 
M2 table, before you manually 
move all of the fields in M2 into 
M1, newly added fields will still 
be put into M2.

 l The Row-Overflow feature is 
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great for allowing occasionally 
rows longer than 8,060 bytes, 
but it is not well suited for the 
majority of rows being over-
sized which can lead to a drop 
in query performance.

QCCR1E99835 If you modify popup.ci.info pop-up subforms that use the SD.open.interaction 
format and are associated with the Affected CI field, you find that display values 
are not displayed in Comfill fields or in arrays.

The values in Comfill fields and in 
arrays are now displayed correctly in 
modified popup.ci.info pop-up 
subforms.

QCCR1E100151 The load balancer does not correctly identify the quiesce-mode in the Service 
Manager client.

The load balancer correctly identifies 
the quiesce-mode in the Service 
Manager client.

QCCR1E100406 When you run equivalent queries on the dataModEvent table, different results are 
returned.

The issue is fixed by dispatching the 
"not" operator recursively until there is 
no "AND"/"OR" underneath.

QCCR1E101528 When you try to retrieve the probsummary records by using a simple query, the 
legacy connection closes and a "Signal 11" error is generated.

You can now retrieve the probsummary 
records by using a simple query as 
expected.

QCCR1E102329 There are memory leaks in Service Manager source control. The memory leaks are now fixed.

QCCR1E102701 The focus is lost after you click Cancel from a confirmation page. The focus is retained after you click 
Cancel from a confirmation page.

QCCR1E102763 The focus is lost when you select a record in System Status, and then refresh the 
display.

The focus remains in the record when 
you refresh the display in System 
Status.
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QCCR1E102775 The focus is lost when you click Back from a record selection page. For example, 
when you clear the Category field of an incident record, click Fill and then click 
Back in the category selection page, the focus moves to the Incident ID field.

The focus is retained when you click 
Back from a record selection page. In 
the given example, the focus remains 
in the Category field.

QCCR1E103106 When you apply the Service Manager 9.32 applications patch to your 
environment, the process fails and a "Signal 11" error is generated.

The "Signal 11" error was caused by a 
NULL pointer. Service Manager now 
checks the pointer whether it is NULL 
before using it. Therefore, the process 
does not fail and no "Signal 11" error 
occurs. 

QCCR1E103235 Auto-refresh does not work when the viewrecordlist parameter is disabled in the 
web client URL.

When the viewrecordlist parameter is 
disabled, views are automatically 
refreshed as expected.

QCCR1E103300 Word (.docx) files cannot be pushed to Service Anywhere because sending and 
receiving binary data is not supported.

You can now send and receive binary 
data by setting the 9th (<Binary 
request data>) and 10th (<Binary 
response data>) parameters of 
"doHTTPRequest" to "true".

QCCR1E103456 When you use the "Any of these words" text search option to export records to 
Excel or to a text file, some records are not exported.

All records are exported as expected 
when you use the "Any of these words" 
text search option to export records to 
Excel or to a text file.

QCCR1E103870 The sort order of a view is lost when you refresh the view. The sort order of a view is retained 
when you refresh the view.

QCCR1E104185 The following error is recorded in the server log file:

JRTE E sendResponse() execute failed - Invalid byte 2 of 3-byte UTF-8 
sequence

This error is not recorded in the serer 
log file.
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QCCR1E104187 The coredump is not generated immediately when an exception is thrown from a 
JAVA part.

The Java Virtual Machine Tool 
Interface (JVMTI) is now used to 
monitor the JVM events. The JVMTI is 
loaded during the initialization of the 
JVM. When a JAVA exception is 
thrown, a callback function that is 
registered for the exception event is 
called to generate a coredump.

QCCR1E104624 When you save a record, the Service Manager client is terminated unexpectedly. The Service Manager client is not 
terminated unexpectedly when you 
save a record.

QCCR1E104704 Assume that you search for a record by clicking the Search Specific Type field, 
and then delete that record. When you select any record that is positioned after 
the deleted record in the QBE list, the item details that are displayed do not 
correspond to the selected record.

When you select any record that is 
positioned after a deleted record in the 
QBE list, the item details that are 
displayed correspond to the selected 
record.

QCCR1E105614 When you update an attachment by using a web service call, a memory leak 
occurs.

No memory leak occurs when you 
update an attachment by using a web 
service call.

QCCR1E105949 The web client does not automatically refresh published messages. Now, published messages are 
automatically refreshed even if the 
marquee widget is not on the last 
opened tab window.

QCCR1E106604 The Sequence Number thread terminates with a "Signal 11" error, and you receive 
the following error message:
Warning: semaphore 10 held by pid xxxx

The special error code from the Oracle 
database is now handled correctly.
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QCCR1E106783 Assume that a dataModEvent table is created or updated in an Oracle 
environment.

The "oldValue" field in the table is a one-digit value (such as "8") and the 
"newValue" field in the table is a two-digit value (such as 16). In this situation, the 
"newValue" field disappears, and the record is corrupted.

This issue was caused by an 
optimization of the LOB read/write 
operation (QCCR1E72505). The 
change to the LOB read operation is 
now reverted.

QCCR1E107296 The Deny Quote transaction in SRC is slow because JGroups communication 
times out.

Currently, the network protocol for 
JGroups communication is UDP. 
However, UDP is not reliable; 
occasionally the packet may be lost, 
causing the JGroups operation to time 
out. A re-send mechanism, called 
RSVP, is added to relieve this 
problem. However, this does not 
resolve the packet loss problem 
completely.

QCCR1E108270 After you delete a record from the CI list, item selection does not work as 
expected in the QBE list.

You can now select items in the QBE 
list as expected after you delete a 
record from the CI list.
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QCCR1E109363 When you create an operator record by using a template that has security groups 
defined, subsequent changes to the template can result in the security group array 
becoming corrupt or not reflecting the correct values.

The operator's security groups array 
now matches the template that is 
assigned to the operator.

Note: The following limitation still 
exists when an operator record's 
template is switched from one 
template to another:

If an operator record has group1 in 
its security groups array when its 
template is NULL, and if group1 is 
in the security groups array of 
template_1 but not in that of 
template_2, the following behavior 
occurs: 

When you assign template_1 to 
the operator record , the operator 
record has group1 in its security 
groups array; however, when the 
record then switches to template_
2, group1 is lost in its security 
group array. To work around this 
issue, first switch the template 
from template_1 to NULL, save it, 
and then switch the template from 
NULL to template_2.
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QCCR1E110146 The following message appears randomly:

API=OCIStmtExecute [in sqociSelectSome], Statement=SELECT 
m1."TYPE",m1."KEY_CHAR",m1."KEY_NUMERIC",m1."NAME" FROM 
CLOCKSM1 m1 WHERE ((m1."TYPE"=:Y and m1."KEY_CHAR"=:Y and 
m1."NAME"=:Y)) ORDER BY m1."TYPE" ASC,m1."KEY_CHAR" 
ASC,m1."KEY_NUMERIC" ASC,m1."NAME" ASC (apm.start.clock,select) 
SQL code=1008 message=ORA-01008: not all variables bound 
(apm.start.clock,select)

The error message no longer appears.

QCCR1E110162 Several memory leaks were found in the RTE source code. These memory leaks are now fixed.

QCCR1E111038 Users cannot log on to the Service Manager server on a Windows platform when 
FIPS with LDAP is enabled.

Rebuilt the FIPS module to enable 
users to log on to the Service Manager 
server on a Windows platform when 
FIPS with LDAP is enabled.

Web client
CR Problem Solution

QCCR1E31509 The Web client cannot use a specific element 
from an array to display in a QBE list. For 
example, if a QBE column is set up to display 
',n', the entire array content is displayed 
instead of the nth element. 

Now the Web client can use a specific element from an array to display in 
a QBE list. For example, if a QBE column is set up to display ',n', the nth 
element is displayed. 
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QCCR1E57288 The Message box of the "mb.ok" RAD 
application displays the Information icon in the 
Windows client but the Warning icon in the 
web client.

The Message box of the "mb.ok" RAD application displays the Information 
icon in both the Windows client and the web client.

Note: After this fix, the correct message level and its corresponding 
icon (such as Information, Warning, or Error) are displayed in a pop-up 
message box according to the message type or style.

Before this fix, the "Warning" icon is always displayed in a pop-up 
message box in the web client. You may find some previous 
"Warning" messages are now displayed as "Error" or "Information" 
messages in the web client. This is true for both out-of-box messages 
and your tailored messages (if any).

If a previous “Warning” message from your tailored system is now 
displayed as an “Error” message, you might previously have set the 
message as an error. In this case, if it is more appropriate to display 
the message as a warning, set the message as a warning.

Page 91 of 162

Release Notes
Fixed defects

HP Service Manager (9.34)



CR Problem Solution

QCCR1E57782 The Foreground Color condition in a Table 
control of a record detail form does not work in 
the web client.

The Foreground Color condition works as expected in tables in the web 
client.

Note: Condition values that contain special characters should be 
enclosed in double-quotes (for example, "HR > Policy"), or the 
condition will be ineffective.

Limitations:

 l If you edit the value of a cell to make it satisfy a color condition after 
the page is loaded, the new color is not applied immediately. The new 
color takes effect only after the page is saved and refreshed.

 l If a default color is specified for a table, it takes no effect for new rows 
inserted into the table after it is loaded. The default color takes effect 
on the new rows only after the page is saved and refreshed.

QCCR1E58402 URLs that are included in the description of a 
Catalog item do not work as expected in the 
web client.

URLs that are included in the description of a Catalog item work as 
expected in both the Windows client and the web client.

Note: For correct label wrapping in the web client, the URLs should 
be formatted as follows:

 l URLs should start with a specific protocol (such as http(s), ftp(s), 
www, or file) and end with a space.

 l Mail addresses should contain "@" and be separated from other 
words by a space.
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QCCR1E63006 The Data Changed Event for a Comfill is not 
triggered when the value is changed by the Fill 
operation in either the web or the Windows 
client.

The Data Changed Event for a Comfill is triggered on the web client when 
the value is changed by the Fill operation.

 l Now the input box and all the possible buttons (Fill button, Find 
button or Combo button) that consist of a Comfill are considered 
an integral part for the Data Changed Event. For example, if you 
directly change the value in the input box and press Tab to set 
focus to the Fill button, the Data Changed Event is not triggered 
immediately. In this case, the Data Changed Event is triggered 
only if you press Tab to set the focus to another control on the 
page.

 l For Comfills without the Find button, you will be unable to perform 
the Find operation using Alt+F8. However, if there is a Find 
button on the toolbar, you can perform the Find operation by 
clicking the Find button.

QCCR1E67098 Suppose a specific language pack is installed 
in Service Manager. After you set the 
language preference in Internet Explorer to this 
language, the default language for the Login 
page in the web client is still English.

The language used in the web client is now determined by the following 
settings, in order of descending priority: 

 1. Language specified in the URL 

 2. Language retrieved from the browser cookie 

 3. Browser language preference 

 4. Operating system default system locale

Now, after you set the language preference in Internet Explorer to a 
specific language, clear the browser cookies and access Service Manager 
without setting the language in the URL, the default language for the Login 
page is the one that you specified.
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QCCR1E70740 In the Employee Self-Service client, the 
Mandatory indicator does not appear for fields 
that are newly defined for a Service Catalog 
Item.

Now, using any mode In the web client, the Mandatory indicator appears 
for all newly defined fields for a Service Catalog Item.

QCCR1E74669 Some tables in the detail form are not 
generated in table-related tags and are not 
recognized by JAWS as tables.

Now all tables in the detail form are recognized by JAWS as tables despite 
the details of the HTML tags.

QCCR1E75661 If you set the operating system locale, Internet 
Explorer language preference, and JAWS 
voice profile to German, JAWS reads text in 
the Service Manager web client in what seems 
to be a German accent.

The language attribute is added to the HTML tag. Now, when you set the 
operating system locale, Internet Explorer language preference, and 
JAWS voice profile to German, JAWS reads text in the Service Manager 
web client correctly in German.

QCCR1E79466 JAWS does not recognize the Record list as a 
table.

JAWS now recognizes the Record list as a table.
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QCCR1E89373 The hover form is not displayed for the 
Contact field in an interaction record. This 
issue occurs in the following scenario:

 1. You open an interaction record. 

 2. You click Knowledge Management > 
Retired Documents. 

Service Manager creates a duplicate tab, 
attempting to load the retired documents 
form.    

Prerequisite: Your system has no retired 
documents. 

Service Manager displays a "No records 
found" information dialog and closes the 
new tab. 

 3. You click OK in the dialog, return to the 
interaction record, and hover over the 
Contact record.     

The hover form is not displayed.

The hover form is always displayed without errors.

QCCR1E91140 Many links and images in the web client are 
dragable, which can easily cause 
misoperation. For example, If you click the the 
Fill button and then drag it inside the input box, 
the javascript statement of the link of the Fill 
button is copied to the input box of the Comfill.

Now, almost all links and images in the web client are non-dragable so that 
they will not cause misoperation.
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QCCR1E92536 The accessibility of tables in the detail form is 
not supported very well in the Web client. The 
major issues are: 

 l JAWS does not read off a meaningful table 
summary.

 l The column headers are not recognizable 
by JAWS.

 l The column headers and cells with a link in 
some tables are not accessible using the 
Tab key.

The accessibility of tables in the detail form is now well supported in the 
Web client. You can use JAWS table related commands to navigate  
through the column headers and cells in a table.

 l JAWS reads off a meaningful table summary.

 l The column headers are recognizable by JAWS.

 l The column headers and cells are accessible using the Tab key.

Known issue:

JAWS 13 cannot read the Open Calendar icon in a table if you use 
Internet Explorer 8 or 9.

QCCR1E97577 When you use the Up and Down arrow keys 
to navigate drop-down lists for Combo boxes 
and Comfills in Accessible mode, JAWS does 
not read the content of items in the list.

When you use the Up and Down arrow keys to navigate drop-down lists 
for Combo boxes and Comfills in Accessible mode, JAWS reads the 
content of items in the list.

QCCR1E97678 The Calendar for the Date control date picker 
is not correctly displayed in Firefox if the date 
value is invalid.

The Calendar for the Date control date picker is always correctly displayed 
in Firefox even if the date value is invalid.

QCCR1E98242 In the form for searching for Known Errors, you 
can see items with a "Known Errors" prefix in 
the value list for the Phase combo box. 
However, if you change the value of the "Look 
For" field in the search form to "Problem," the 
value list for the Phase combo box remains 
unchanged.

After you change the value of the "Look For" field in the search form to 
"Problem," the value list for the Phase combo box is updated accordingly 
and you can see items with a "Problem" prefix in the combo box.

Page 96 of 162

Release Notes
Fixed defects

HP Service Manager (9.34)



CR Problem Solution

QCCR1E99401 If you register a new Interaction in the web 
client and immediately close it, the message 
"Interaction SD*** has been closed" is not 
displayed immediately.

If you register a new Interaction in the web client and immediately close it, 
the message "Interaction SD*** has been closed" is displayed 
immediately.

QCCR1E99739 When you view the Configuration Item form 
Relationship subform for CIs in the web client, 
you receive an error message if you click a 
related item that has a backslash (\) in the item 
name.

When you view the Configuration Item form Relationship subform for CIs 
in the web client, the related item opens without errors.

QCCR1E100789 In Forms Designer, if you set the Visible 
property of one field to "false" and then use 
this field in one DVD (Dynamic View 
Dependencies) property (such as Visible 
Condition), a JavaScript error occurs and the 
evaluation of Visible Condition fails when the 
form is displayed in the web client. 

In Forms Designer, if you set the Visible property of one field to "false" and 
then use this field in one DVD (Dynamic View Dependencies) property 
(such as Visible Condition), the Visible Condition is evaluated as expected 
when the form is displayed in the web client. 

QCCR1E101309 You cannot set the focus to the "Description" 
column in the table in the "Service Catalog 
Approval Activities" section when you use the 
accessibility client.

You can set the focus to the "Description" column in the table in the 
"Service Catalog Approval Activities" section when you use the 
accessibility client.

QCCR1E101305 Read-only fields and editable fields have the 
same appearance on the accessible client.

Read-only fields and editable fields have different appearances on the 
accessible client.

QCCR1E101304 When you use the keyboard to select a row in 
the Categories table in a Knowledge 
Document, and then to invoke the Remove 
button, the selected category is not removed.

However, you can remove a category item by 
using the mouse.

Now you can use the keyboard as well as the mouse to remove an item 
from the Categories table in a Knowledge Document.

Prerequisite: You must move the Add and Remove buttons to the right of 
the table in the form in Forms Designer. Therefore, when you tab out of the 
table, the related buttons receive the focus first.
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QCCR1E101302 When you set the cursor to a required field, the 
screen reader will name the field. However, 
the screen reader does not state that the field 
is a required field.

When you set the cursor to a required field, the screen reader will name the 
field as well as state that the field is a required field.

QCCR1E101441 When you open a new change in a system that 
has Process Designer Content Package 4 
(PDCP4) installed, the new Change page is 
not displayed for several seconds if there are a 
large number of Task Template records in the 
system.

When you open a new change in a system that has Process Designer 
Content Package 4 (PDCP4) installed, the new Change page is displayed 
quickly even if there are a large number of Task Template records in the 
system.

QCCR1E101728 The color contrast of text on inactive tabs 
does not conform to the Web Content 
Accessibility Guidelines version 2 (WCAG 
2.0) requirement.

The color contrast of text on inactive tabs now conforms to the Web 
Content Accessibility Guidelines version 2 (WCAG 2.0) requirement.

QCCR1E101861 JAWS does not read information in new 
Calendar and Attachment windows.

JAWS reads the information in new Calendar and Attachment windows.

QCCR1E101916 When the "New kmfeedback" page is loaded, 
the Frame name in the page is not read by 
JAWS, even if the frame name receives focus 
by default.

When the "New kmfeedback" page is loaded, the first editable control now 
receives focus by default. You can use the following JAWS keystrokes to 
move through all the frame names in the current page:

 l M: go to the next frame

 l Shift+M: go to the previous frame

 l Insert+F9: list the frames

QCCR1E102043 All Popup windows share the same general 
title ("HP Service Manager").

Popup window titles are now appended with window-specific information.
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CR Problem Solution

QCCR1E102364 When you are prompted by a message box, 
JAWS does not read the content of message 
box.

When you are prompted by a message box, JAWS reads the content of 
message box.

Known issue: 

JAWS always reads "ok, yes, no, cancel," irrespective of the buttons that 
are present in the message box.

QCCR1E103206 You cannot use the Alt+F1 keyboard shortcut 
in the web client to access a display option 
whose GUI option value is set to "1."

You can now use the Alt+F1 keyboard shortcut in the web client to access 
a display option whose GUI option value is set to "1."

QCCR1E103494 If you add a Marquee to a form and set the 
Input property of the Marquee to a variable, the 
Marquee is not automatically refreshed on the 
web client after the value of the variable is 
changed.

If you add a Marquee to a form and set the Input property of the Marquee to 
a variable, the Marquee is automatically refreshed on the web client after 
the value of the variable is changed.
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CR Problem Solution

QCCR1E103797 If you have an existing Service Manager open 
in the web client, and then you use the Hash 
URL to access a record directly, the existing 
session expires, and you receive the following 
message:

This page has expired. Please close it.

You must then log in to the new session to 
view the record. However, you receive the 
following message:

You are trying to connect to a different 
server while the Service Manager main 
application is already open in another 
browser tab. If needed, save your work in 
the other tab first, and then continue.

As the previous session is already expired, 
you are unable to do this.

If you have a session open in the Service Manager web client, this session 
does not expire when you use the Hash URL to access a record directly. 
Instead, the record opens in a new browser tab.

QCCR1E104466 The DVD select statement does not work for 
any Combo box on the ToDo page.

The DVD select statement now works for any Combo box on the ToDo 
page.

QCCR1E104627 If two Text Area controls in two different 
notebook tabs share the same input value, and 
one of the tabs has a DVD visible condition 
that is evaluated to false, one additional new 
line is inserted after each paragraph in the Text 
Area after the page is refreshed due to a form 
submit action.

If two Text Area controls in two different notebook tabs share the same 
input value, and one of the Tabs has a DVD visible condition evaluated to 
false, the content in the Text Area remains unchanged after the page is 
refreshed due to a form submit action.

Page 100 of 162

Release Notes
Fixed defects

HP Service Manager (9.34)



CR Problem Solution

QCCR1E104793
 

If you set focus to the column header of a table 
in the detail form, there is no focus style to 
highlight it. As a result, it is very hard for you to 
know which column header is in focus.

If you set focus to the column header of a table in the detail form, now 
there is a focus style to highlight it so that you can easily know which 
column header is in focus.

QCCR1E105562 The web page is refreshed after you press 
Enter on a notebook tab in Firefox or Chrome.

The web page is no longer refreshed after you press Enter on a notebook 
tab in Firefox or Chrome.

Known issue: The focus sequence is different in Chrome. If you press 
Enter on a notebook tab and then press Tab, the focus does not move to 
the content of the current notebook. Instead, it moves to the next 
notebook. The focus moves to the content of the current notebook only 
after it finishes moving through all the notebooks.

QCCR1E105784 The page hangs when you perform a Validate 
Format operation in the web client.

The Validate Format operation now works as expected in the web client.

QCCR1E105915 If you set focus to a cell that does not contain 
a link in a table and press Enter to select the 
row, the page is refreshed and the focus is 
reset.

If you set the focus to a cell that does not contain a link in a table and 
press Enter, the current row is selected. If the first column contains a link, 
the focus moves to that cell.

QCCR1E106343 The web client hangs if you search for the 
string "sub" in the Forms Designer page. 
Additionally, the following Javascript error is 
displayed in the browser 
console:

<Uncaught Ext.JSON.decode(): You're 
trying to decode an invalid JSON String>

Now, if you search for the string "sub" in the Forms Designer page, the 
search result page is displayed correctly without any error.
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CR Problem Solution

QCCR1E106773 Assume that you deploy the webtier directly 
under the Tomcat root directory. When you 
access the webtier and click any Cancel, 
Back, or OK button, or perform any other 
operation that closes the current tab, you 
receive the following network error:

Network Error (dns_unresolved_
hostname) 

Your requested host 
"processmessages.jsp" could not be 
resolved by DNS

Assume that you deploy the web tier directly under the Tomcat root 
directory. When you access the web tier and click any Cancel, Back, or 
OK button, or perform any other operation that closes the current tab, you 
can close the current tab as expected.

QCCR1E107280 When you press and hold the mouse wheel on 
a record list, the Chrome browser tab crashes 
after some operations, such as moving or 
clicking.

The mouse wheel event is now disabled so that this issue will no longer 
occur.

QCCR1E107505 If you have the Arabic language pack installed 
in Service Manager, you find the Mandatory 
indicator of any Comfill is displayed 
overlapping the input box of the Comfill when 
you access the web tier by using Internet 
Explorer.

If you have the Arabic language pack installed in Service Manager, you 
find the Mandatory indicator of any Comfill is displayed on the left of the 
input box of the Comfill when you access the web tier by using Internet 
Explorer.

QCCR1E107531 Cell content that does not contain a link is read 
as "link" + "cell content" in the JAWS Table 
Layer Mode.

Cell content that does not contain a link is read as simply "cell content" in 
the JAWS Table Layer Mode.

QCCR1E107535 In JAWS Table Layer mode, JAWS reads 
redundant content when the cell has no 
content.

In JAWS Table Layer mode, JAWS does not read redundant content when 
the cell has no content.

Page 102 of 162

Release Notes
Fixed defects

HP Service Manager (9.34)



CR Problem Solution

QCCR1E107710 If a Comfill field is used to display an array of 
values, an array of controls is displayed for 
this field. However, the label of the Comfill 
field is not read by JAWS.

If a Comfill field is used to display an array of values, an array of controls 
is displayed for this field. Now, the label of the Comfill field is read by 
JAWS when the focus is on the first field.

QCCR1E107773 Some buttons overlap with the color selection 
table. 

The height of the "wizard.subformat" subformat is updated to remove the 
overlaps.

QCCR1E107943 If you set both the Value List and Display List 
for a Comfill control, the tooltip for the Comfill 
is displayed as "Fill Field" and the label for the 
Comfill is missing in the web client.

If you set both the Value List and Display List for a Comfill control, the 
tooltip for the Comfill is displayed as "Fill Field %Label%." in the web 
client.

For example, if the label for this Comfill is "Category," then the tooltip is 
displayed as "Fill Field Category."

QCCR1E107955 JAWS does not recognize the Attachment 
table in a detail form as a table.

JAWS now recognizes the Attachment table in a detail form as a table, 
with the following features:

 l The header of the Attachment table is read as "[header text] column 
header."

 l With JAWS running, when you press Ctrl + Insert + T, the attachment 
is listed in the table list dialog, named as "Attachments."

 l With JAWS running, you can press T to iterate all tables, including the 
Attachment table.

 l With JAWS running, all checkbox states are read correctly, and you 
can use the Space key to toggle states.
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CR Problem Solution

QCCR1E108842 If you resize the browser so that part of the 
"More" button in the toolbar is invisible, a 
button with label ">>" is displayed on the right 
of the toolbar for calling out the "More" button. 
If you click the ">>" button, nothing happens.

If you resize the browser so that part of the "More" button in the toolbar is 
invisible, a button with label ">>" is displayed on the right of the toolbar for 
calling out the "More" button. If you click the ">>" button, the "More" 
button is displayed.

QCCR1E108932 A Javascript error occurs when you select a 
Task in the Task Planner in Internet Explorer 
8.

No Javascript error occurs when you select a Task in the Task Planner in 
Internet Explorer 8.

QCCR1E109024 The date control does not work in Firefox if you 
specify a mask and output conversion. 
"undefined NaN" is displayed instead of the 
year and month, and the date is not displayed.

The date control now works as expected in Firefox if you specify a mask 
and output conversion.

QCCR1E109058 When load balancing is configured and the 
honorUrlPort parameter is enabled in the 
Service Manager system, if you refresh a 
page, the web client displays a new page with 
the following incorrect message:

You are trying to connect to a different 
server while the Service Manager main 
application is already open in another 
browser tab. If needed, save your work in 
the other tab first, and then continue.

After you click the "OK" button in the 
message, you are logged off the web client.

When load balancing is configured and the honorUrlPort parameter is 
enabled in the Service Manager system, if you refresh a page,  the page is 
refreshed without any message.
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CR Problem Solution

QCCR1E110651 The focus indicator for focusable elements is 
not highly visible.

The focus indicator has been enhanced as described below:

 l In index mode, the button focus border color has been changed to 
black.

 l In accessible mode, the focus border width has been changed to 2px.

QCCR1E110799 When you use a JAWS command to open the 
Region List, JAWS reads out the System 
Navigator region as "Navigation", which is not 
meaningful.

When you use a JAWS command to open the Region List, JAWS reads 
out the System Navigator region as "System Navigator Navigation."

QCCR1E110780 The check box state for an attachment table is 
always read off by JAWS as Not Checked.

The check box state (Checked/Not Checked) of an the attachment table is 
read off correctly by JAWS.

QCCR1E110969 After the web page is loaded, JAWS reads 
something that is not related to the focused 
readonly element on the screen.

After the web page is loaded, JAWS now reads the correct content of the 
focused readonly element on the screen.

QCCR1E111063 There is no way to skip records in a record list. 
You need to tab through all records before 
exiting the record list.

You can use the following keyboard shortcuts on tables: 

 l Ctrl + Home/End: Move the focus to first/last cell of a table. Note: In 
Chrome, you must use Alt + Home/End instead.

 l  Home/End: When focusing on a cell in a row, move the focus to the 
first/last cell in the current row.

 l  Ctrl + Page Up/Down: Navigate to the previous / next page.

QCCR1E112010 Keyboard shortcut "Alt+F8" is still working 
when the "Find" icon for the Comfill widget is 
set as invisible. 

Keyboard shortcut "Alt+F8" is disabled for the Comfill widget when the 
"Find" icon is set as invisible.
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Windows client
None.
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Known problems, limitations, and workarounds
This software release has the following known issues and limitations. This is a cumulative list of known issues and limitations in Service 
Manager, including those that are already documented in previous release notes (Service Manager 9.33 and patches, Service Manager 9.32 and 
patches, and Service Manager 9.31 and patches).

Issues  in Service Manager 9.31 and patches
Global ID Problem Workaround

QCCR1E63663 The Service Manager client loses connectivity 
during JavaScript execution of the file.list RAD 
application.

No workaround available.

Created a knowledge article (KM1166532), 
which states that Service Manager does not 
currently support calls from JavaScript on RAD 
applications that use the rio/fdisp panels.
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Global ID Problem Workaround

QCCR1E57385 When Service Manager is running on Unix, the 
legacy listener may log intermittent signal 11 
upon CIT initial connectivity test if exec-shield 
is not set properly.

Use one of the following solutions to solve this 
issue on Unix.

Solution 1:

Connect Connect-It to the Web Services 
connector instead of the Legacy Listener 
connector.

Solution 2:

Before connecting Connect-It to the Legacy 
Listener connector, do the following:

 1. Add  usethreading:0 in the sc.ini file, which 
is located in <Service Manager server 
installation path>\LegacyIntegration\RUN.

Note: For 64-bit RedHat Linux servers 
only, you can alternatively run the 
following shell commands as root:

# sysctl -w kernel.exec-shield=0

# sysctl -w kernel.randomize_va_
space=0

 2. Start the legacy listener.
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Global ID Problem Workaround

QCCR1E67491 When the collation of the db instance is 
Chinese_PRC_BIN, Web service clients fail to 
connect to Service Manager. Only ASCII 
operator names are supported, so only ASCII 
operator names can be used. 

Note: This issue only exists in Web service 
integrations. Therefore, the Service 
Manager clients do not have this problem.

When Service Manager is handling an incoming 
SOAP request, the authorization string is 
decoded by BASE64Decoder. Service Manager 
uses the decoded string value to construct a 
UTF-8 string that is used in the RTE. However, 
the authorization string is in the header and 
Service Manager does not know the charset or 
encoding of the underling string value, which is 
BASE64 encoded. 

Therefore, if the underlying string value is not 
UTF-8, this problem will occur. In Service 
Manager, when fetching an operator record from 
the database, no matter what collation the 
database uses, the operator record finally will 
get a UTF-8 operator value. However, even if 
users put the same value in the authorization 
header, the operator name may differ because of 
the charset/encoding issue. Because of this, the 
operator will fail to log on.  

This is a limitation of Service Manager. Do not 
use non-ASCII characters in operator names. 
Created a knowledge article (KM1442479) to 
document this limitation. 
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Global ID Problem Workaround

QCCR1E75182 HTML email truncates the body of the message 
and sends the HTML code without translating it.

When the content of an HTML email template 
exceeds 8192 bytes in size, the content will be 
truncated and displayed as HTML code.   

Make sure your HTML email templates do not 
exceed this size limit.

QCCR1E77563 Signal 11 error is received when calling the 
toXMLString() routine of the Users object. 

No workaround is currently available.

QCCR1E88222 An unload file that is exported from an Oracle to 
an SQL Server database fails to import when the 
unload file already contains a RECORD_KEY 
field and the length of first unique key exceeds 
the db limitation.

This request is caused by the product running in 
an unsupported configuration. Change to a 
documented and supported configuration. If the 
problem still exists in a supported environment, 
contact HP Support.

To work around this issue, do not use 
"RECORD_KEY" as a SQL Name for a field in 
dbdict.  This field name is reserved by Service 
Manager.  To do this, follow these steps:

 1. Enter dbdict in the Service Manager 
command line box.

 2. Enter "esdquestions" in to the search field, 
and then click the Search button.

 3. Select the "record.key" field, and then 
change the SQL Name from "RECORD_
KEY" to anything else.
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Global ID Problem Workaround

QCCR1E74808 After clicking the Cancel button in the Condition 
Editor from the Workflow Editor, the current tab 
sometimes becomes a blank screen and the tab 
cannot be closed.

No workaround is currently available.

QCCR1E105052 In Task Planner, the tooltip of a task displays 
the change phases with their names instead of 
their display names.

No workaround is currently available.

Issues  in Service Manager 9.32 and patches
Service Manager  Issues

Global ID Problem Workaround

QCCR1E64377 In the web client, when a Configuration Item (CI) 
record is opened, the CI label does not show (or 
only shows for the first time) in the CI 
Visualization (Relationship Graph). This issue 
occurs only when JRE 6 is used.

As Oracle has fixed this Applet issue, JRE 6 
customers need to upgrade their JRE to the 
latest JRE6 or JRE7 on the machine that runs 
Internet Explorer or Firefox in order for CI 
Visualization to display CI labels correctly.
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Global ID Problem Workaround

QCCR1E95725 Due to a known issue in JDK (bug id:7196513), 
CI icons are not displayed correctly in Firefox 
when Httponly cookies are enabled in the web 
application server. 

When Httponly cookies are enabled, users can 
only use Internet Explorer 7 or higher for CI 
icons to display correctly.  As Oracle has fixed 
the Httponly cookie issue as of JDK 7u6, users 
need to install the latest 32-bit JRE (7u6 or 
above) on the machine that runs Internet 
Explorer 7 or higher. 

Note: In Service Manager 9.33 or later,  
users can only use Internet Explorer 8 or 
higher for CI icons to display correctly.

QCCR1E95963 An error occurs when loading a dbdict twice in 
an unload file. The two dbdict records have the 
same name, but different key types:  the first one 
has unique key, while the second's key type is 
primary key. 

Do not export to an unload file a dbdict record 
whose key type has changed. 
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Global ID Problem Workaround

QCCR1E97260 When SSL is enabled between the web 
application server and Firefox, a ClassNot found 
Exception error displays in the workflow section 
of the Change form. This issue does not occur in 
IE or in Firefox without SSL enabled.

There are two workarounds:

 l Use Internet Explorer instead of Firefox. 

 l If using Firefox, import the client certificate 
into the Java console on the end user's 
machine. Here are the steps for Windows 7:

 a. Open Control Panel, and i n the Control 
Panel Search box enter "Java 
Control Panel".

 b. Double-click the Java console icon to 
open the Java console.

 c. On the Security tab, click Manage 
Certificates ....

 d. On the Certificates window, select 
certificate type: Client Authentication, 
and click Import.

 e. Follow the wizard and import the client 
user's certificate.

QCCR1E97492 Clicking the Back button on the CI Visualization 
page (which opens when you click More > 
Expand CI Visualization  in a CI record) 
causes a Firefox crash.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E97603 If a format that contains a button with Enable 
condition is created or modified by using a 
Service Manager 9.31 patch 1 server, when 
using it in Service Manager 9.31 GA or earlier, 
the client crashes. However, formats created by 
using the Service Manager 9.31 GA or earlier 
server work fine.

Upgrade both of the Service Manager server and 
client to the same patch level: Service Manager 
9.31 patch 1 or later.

QCCR1E94657 When PDCP4 is applied, the first group on the 
form is not shown in the Jump Address drop 
down list.  

Move the scroll bar to the top-most position and 
then you will see the first group.

QCCR1E97856 In a single-line text field, some special 
characters whose HTML code is &#x...; 
(where ... stands for a hex number) are not 
represented as their original format. Instead, 
they display as &#x...;. However, such 
characters are represented as the original format 
in other widgets (textarea, label, message 
panel, and so on).

No workaround is currently available.

QCCR1E93604 The HTTP Response Code is 200 instead of 
400 when a RESTful request uses an invalid 
sort field separator (for example, a plus symbol).

Use a valid sort field separator. 

QCCR1E94204                     Because of the incorrect status, the operation 
could not proceed after merging a record.

Reset the status of this record (for example, 
reopen the closed record) and perform the last 
operation again.

QCCR1E94206 The last operation could not be repeated after 
merging a record because the  button for the last 
operation disappears. 

Reset the condition for the button in this record, 
for example, Reopen the closed record, and 
perform the last operation again.

Page 114 of 162

Release Notes
Known problems, limitations, and workarounds

HP Service Manager (9.34)



Global ID Problem Workaround

QCCR1E96353 RESTful API: An incident record is successfully 
resolved when posting an incident resolve 
action with a blank "ClosureCode" and 
"Solution".

Validation is not performed for the fields. 

To work around this issue, validate them at the 
RESTful client side, or    manually add validation 
for the fields to the format control.

QCCR1E96391 Restful API: Results are in the wrong order 
when sorted by an array field.

This issue occurs because the  Service Manager 
RTE does not support sorting by array fields. A 
list is returned without any error message.

No workaround is currently available.

QCCR1E97898  Restful API: A 400 Bad Request error occurs 
when a RESTful API request is a cross-table 
join query.

The RESTful API framework supports simple 
queries and Service Manager native queries.  

Currently RESTful API framework does not 
support cross-table SQL queries.   

QCCR1E98320 When a record is removed after being read, the 
Merge function still allows the user to merge the 
record and the user's input is lost. 

No workaround is currently available.

QCCR1E98227 In Approval Delegation wizard, go to another 
page (do not change the delegation module) 
after choose the operator to delegate in "Select 
Approval Groups" page, then back to "Select 
Approval Groups" page again. You will find a 
blank line is displayed in the right table, instead 
of the operator record.  

This is only a display issue, and will not impact 
the functionality.  If you need to remove the 
operator from the delegation list, choose the 
blank line, and then click the remove icon; 
otherwise the operator will be successfully 
delegated once you save the update. 
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Global ID Problem Workaround

QCCR1E98576 When there are conflicted updates on system 
fields, the system displays the message "The 
conflicted fields cannot be merged. Reload the 
record.", whereas the Merge  button is available. 
Actually, the merge function should not be 
available in such case. 

Ignore the Merge button. Reload the latest 
record to edit this record again.

QCCR1E98398 When you are updating a record and adding 
attachments to this record, if your updates 
conflict with another users' updates or the 
updates of a background process, the 
attachments will be lost after either automatic or 
manual merge.

After automatic or manual merge, add the 
attachments again before saving the merged 
result of the record.

QCCR1E98411 SRC failed to retrieve service catalog items 
from Service Manager on upgrade from Service 
Manager 7.11 to Service Manager 9.32.

In the svcCatalog dbdict, the id.attach field is 
character type, which should be number type. 
The id.attach field is an alias of the id field in the 
svcCatalog table.

To fix the issue, change the field type using the 
Dbdict Utility.
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Global ID Problem Workaround

QCCR1E98618 Subcategory data on the Incident form is not 
available after upgrading from ServiceCenter 6.2 
to Service Manager 9.32.

Subcategory data is not upgraded.

If necessary, manually add the subcategory 
data.  

 1. Enter db in the Service Manager command 
line box.

 2. In the Table field, enter subcategory, 
and click Search. 

 3. For each Catagory in the dropdown list, add 
the following Areas (enter a value in the 
Area field and click Add):  access, data, 
failure, hardware, performance, 
and security.

QCCR1E98475 With Process Designer Content Pack 9.30.3 
applied, the Merge functionality does not work 
when a user clicks Save & New in an 
interaction record opened through a search. 

 1. Open an interaction through a search.

 2. Update the Title.

 3. Another back-end process has updated the 
Title to another value.

 4. Click Save & New. An error occurs: This 
record has changed since you 
selected it.

You cannot perform Merge for the 
conflicted updates as expected.

If you encounter the error "This record has 
changed since you selected it." when clicking 
the Save & New button on an interaction 
opened through a search, to avoid abandoning 
your updates, do not use the Save & New 
button to save your updates; instead, first click 
the Save button to save your updates with the 
merged result, and then register a new 
interaction from the navigation menu.
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Service Request Catalog Issues

Global ID Problem Workaround

QCCR1E90074 When entering a search string in Service 
Request Catalog, auto-complete does not work 
if the browser's preferred language is set to an 
East Asian language (for example, Simplified 
Chinese).

No workaround is currently available.

QCCR1E98339 Custom fields do not load the DEFAULT 
company value when the checkout panel is 
empty for one of the three checkout panels of 
your company.

After upgrade, you should manually add the 
same structure configuration of the DEFAULT 
company for the empty checkout panel of your 
company. For example, before upgrade, you, as 
an SRC administrator, only defined custom 
fields for the Service Catalog checkout panel for 
your company. After upgrade to Service 
Manager 9.32, if you want to use the support 
checkout panel and generic support checkout 
panel in SRC correctly, you need to manually 
add OOB configurations for the Support Catalog  
and Generic Support checkout panels, which 
you can copy from those panels of the 
DEFAULT company.
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Issues  in Service Manager 9.33 and patches
Global ID Problem Workaround

QCCR1E100136 After the installation of a language pack, the 
Windows client, if running on an Arabic 
Windows 2008, displays the tooltips of the 
'Added' and 'Forced'/'Updated' columns in the 
content pack results as reversed. 

No workaround is currently available.

QCCR1E101782 In Trusted Sign-On (TSO) mode, if users log in 
to the web client with Simplified Chinese in 
Internet Explorer 10 running on Windows 8 or 
Windows 2012, the web client still displays in 
English instead of in Simplified Chinese.

No workaround is currently available.

QCCR1E103847 An arrow connector in a Process Designer 
workflow might be misaligned when the 
destination phase is vertically too close to 
another phase (this problem was introduced in 
Service Manager 9.33 patch 1 revision 1).

To resolve the issue, move the destination 
phase away enough from the adjacent phase.

QCCR1E103858 It displays auto-open tasks in the task planner 
window  (this problem was introduced in Service 
Manager 9.33 patch 1 revision 1).

No workaround is currently available.
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Issues  in Service Manager 9.34
Global ID Problem Workaround

   

QCCR1E105370 The "Select a section" quick jump text box is not 
displayed.

Click the resize icon.

QCCR1E105375 Service Request Catalog does not allow 
approval delegation for the Time Period module. 

No workaround is currently available.

QCCR1E106074 When you add custom multi-text fields to the 
Service Checkout page, the fields are not 
displayed correctly on the Resubmit page on an 
iPad.

No workaround is currently available.

QCCR1E107572 When you use the arrow keys to move up, 
down, left, and right through cells, JAWS reads 
"Not in the table" incorrectly. 

No workaround is currently available.

QCCR1E107573 When you put the focus on a column header 
after you switch the mode to table layer, JAWS 
reads the names of the first column header to 
the column header currently in focus incorrectly.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E107712 In Internet Explorer 11, pressing F1 does not 
bring up the Service Manager help information.

To work around this issue,follow these steps:

 1. Start Internet Explorer 11 from a desktop 
computer, and then log in to Service 
Manager.

 2. Press Alt to access the menu bar in 
Internet Explorer. 

 3. In the Tools menu, select Compatibility 
View settings. 

 4. A dialog box appears, in which the  "Add 
this website:" field is prepopulated with the 
host name or IP address of your webtier 
host. Click Add to add the website to the 
compatibility view list.

 5. Click Close. The Service Manager web 
page refreshes and opens in compatibility 
mode.

QCCR1E107983 In Google Chrome, you are unable to use the 
Tab key to move the focus to or off the HTML 
Editor.

No workaround is currently available.

QCCR1E108558 When "Virtual PC cursor" is enabled, JAWS 
reads a group name three times when you 
expand the group.

No workaround is currently available.

QCCR1E109151 The grouping grid changes to a paging grid when 
you sort a table in the "Select a Time Period 
category" page.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E109390 Revisions cannot be added when you apply 
PDCP4 production data to Service Manager 
9.34 applications that were upgraded from 
Service Manager 9.32 applications.

No workaround is currently available.

QCCR1E109577 When you log in to the web client by using 
Internet Explorer 8 for the first time, all the 
characters are displayed in an italic font.

Refresh the page in Internet Explorer.

QCCR1E110285 When JAWS 15 runs in Internet Explorer 10 or 
11, the focus does not return to the correct radio 
button when you press Shift+Tab.

No workaround is currently available.

QCCR1E105370 The Quick Jump component is not displayed in 
certain screen resolutions.

No workaround is currently available.

QCCR1E110695 The MySM details page is not displayed in 
Hebrew or Arabic.

No workaround is currently available.

QCCR1E110784 Sortable column headers for editable tables do 
not have a sort icon.

No workaround is currently available.

QCCR1E110085 JAWS reads the words "read only" when the 
focus is on a language combo box.

No workaround is currently available.

QCCR1E110285  When JAWS 15 runs in Internet Explorer 10 or 
11, the focus does not return to the correct radio 
button when you press Shift+Tab.

No workaround is currently available.

QCCR1E110343 The Auto Complete function does not work for 
some fields of the timeperioddefine format. 

No workaround is currently available.

QCCR1E111031 The customized Accessible Description for the 
recordlist table in a wizard cannot be read by 
JAWS.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E111202 When JAWS13 is working with Asian languages 
such as Chinese, Japanese or with the Arabic 
language, the "System Navigator" and 
"Pagination" navigations cannot be listed in 
"Landmarks."

No workaround is currently available.

QCCR1E111084 You cannot use the keyboard to operate on a 
List Builder control when JAWS is running.

No workaround is currently available.

QCCR1E109267 The Label of the Parent Record field cannot be 
displayed correctly when saving an incident 
record.

No workaround is currently available.

QCCR1E111340 When using the Tab key to navigate the 
attachment table, the screen reader cannot 
recognize the input for the last two columns in 
the attachment table.

No workaround is currently available.

QCCR1E110722 Accessibility to the Time period rules table and 
the Time period occurrences table is not good on 
a time period record detail form. 

No workaround is currently available.

QCCR1E112188 If a Comfill field has Auto Complete enabled and 
a data change event (not 0) defined, and a post 
expression/post JavaScript is defined for the 
link for this field, the data change event may not 
work.

Do not enable Auto Complete for the Comfill 
field.

QCCR1E110332 Calendar and Timeperiod in the Module drop-
down list item on the SecArea Search page are 
not translated.

Search for "securityModules" in the global list, 
and then manually add translated strings  for the 
target language.

QCCR1E111326 Cannot open timeperiod and entry records  in 
Embedded Calendar in  Internet Explorer 11. 

Use an older version of Internet Explorer or use 
a different browser such as Firefox or Chrome.
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Global ID Problem Workaround

QCCR1E111994 The Timeperiod Manager cannot see the 
Approval Definition menu when the system 
has no Process Designer content pack applied.

To work around this issue,follow these steps:

 1. Log in to Service Manager Windows client 
as a system administrator.

 2. Type menu in Service Manager Command 
line, and then press Enter.

 3. Type timeperiod in the Menu Name 
field, and then click Search.

 4. Locate the row with the  description of 
Approval Definitions.

 5. Remove and jscall
("security.hasRight", "Common 
Configuration","view")=true" from the 
Condition field.

QCCR1E112097 The Option menu is overlapped by full calendar 
in the Service Manager accessible web client.

No workaround is currently available.

QCCR1E112282 The data is incorrect for "Close in Phase" when 
viewing a task in Task Planner.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E111131 Calendar and Timeperiod in the Module drop-
down list are not translated in the Security Area 
Search page. To see this issue, follow these 
steps:

 1. Log in to the web client with a non-English 
language. 

 2. Go to System Administration > Security 
> Security Area. 

 3. Click the "Module" drop-down list. 

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E112815 The Time Period Management menu and sub-
menus are not displayed after upgrading to 
Service Manager 9.34.

Update the following four out-of-box menu items 
by removing the lioption("Time Period 
Management") and condition:

 l APPROVER GEN

 l CM GEN

 l HOME 

 l timeperiod main 

To update the menu items, follow these steps:

 1. Log on to the Service Manager client as a 
System Administrator.

 2. Type menu in the Service Manager 
command line field, and then press Enter.

 3. Type the menu item name, for example, 
APPROVER GEN, in the menu name field, 
and then press Enter.

 4. Locate the option whose Description is 
“Time Period Management”.

 5. Remove lioption("Time Period 
Management") and from the 
corresponding Condition column. 

 6. Click Save and OK.

 7. Repeat the steps above for the rest of 
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Global ID Problem Workaround

menu items: CM GEN, HOME, and 
timeperiod main.

 8. Log out and log in back. The Time Period 
Management menu and sub-menus are 
displayed.
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Backup and backout instructions
In case you need to restore your Service Manager system to its original state after installing the 
component patches in this release, make necessary backups before each patch installation. If a 
rollback is needed, follow the backout instructions.

Server

Backup
Before you apply the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 9.30\Server.

Note: If you have a horizontally scaled system, be sure to back up the server installation folder for 
each server instance.

Backout
Service Manager  has supported FIPS mode since version 9.32. To run Service Manager in FIPS mode, 
you must upgrade your database to the 256-bit AES encryption algorithm. Once you change all of the 
encrypted fields to use the new 32 character encryption you cannot roll back the RTE and still read the 
encrypted data.

After installing the patch, do the following to backout:

 1. Stop the Service Manager server.

 2. Remove the existing server installation folder.

 3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup, because the 
version of the embedded Tomcat may have dependency on a specific server version.

Note: If you have a horizontally scaled system, make sure that every server instance is 
replaced with its  backup.
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 4. If you have also loaded platform unload files required for your server changes, you must also roll 
back the application changes made by the unload files. See "LocaApplications" on the next page.

 5. For Unix-based platforms other than Linux, make a backup of your JRE if you have not yet 
upgraded to JRE 1.7. 

 6. Restart the Service Manager server.

Web tier

Backup
Before deploying the new web tier, make a backup of the following items:

 l web.xml file

 l application-context.xml

 l log4j.properties

 l splash screen

 l style sheets

 l any other customizations you made, including your webtier-<version>.war (webtier-ear-
<version>.ear) file.

Backout
To roll back to the old web tier:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.
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Windows client

Backup
 1. Make a backup of your Windows client home folder, for example, 

C:\Users\<username>\ServiceManager. Your connections and personalized settings are stored 
in this folder.

Note: This is the out-of-the-box home directory, and could differ from yours if you made 
changes  to <Client>\configuration\config.ini file. If so, back up the files from the 
location specified in that file.

 2. Make a backup of your certificate configuration files if any (Window > Preferences > HP Service 
Manager > Security). For example, your CA certificates file and client keystore file. 

Backout
 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.

LocaApplications
If you plan to upgrade your applications to this release level, make a backup of your database before 
the upgrade, in case you need to restore your database after the upgrade. Creating a backup of the 
entire database and restoring the database if needed is a better approach for a full applications upgrade.

If you plan to load individual unload files in this release, follow the backup and backout instructions 
below.

Backup

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended 
to use Unload Manager to make a backup of the files to be modified by an unload file, because 
Unload Manager can create a backup of your old data during the installation of the unload; if your 
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application version is other than any of these, Unload Manager is not available and you can use 
Database Manager instead. 

To use Unload Manager to make a backup:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of 
the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup:

 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and browse 
to the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this unload.

See the following figure for an example.
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This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are messages 
used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper

datadict activity

dbdict activity

Note: The “activity” file with no records actually represents the dbdict record 
of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 

 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the 
Search button.

 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.
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 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.

Note: If Export/Unload is not available, check the Administration Mode check box in 
Database Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is not 
available in your application version) to roll back to your old data, as described in the following.

To roll back to your old data using Unload Manager:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file generated in the backup process, specify a backup file, and then click Next. 
Details of the unload file display.

 4. Double-click a conflicting object in the table to open the merge tool:
 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager:

 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.

 3. Click Load FG.
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Knowledge Management search engine
To back out your Knowledge Management (KM) search engine changes, make a backup before your 
KM patch installation.

Note: Keep in mind that you also need to roll back KM-related server side and application side 
changes. For details, see the Server and Application backup and backout Instructions.

Backup
Before applying the KM patch and upgrading the JDK and KM embedded Tomcat, do the following:

 1. Make a backup of the search engine installation folder. For example, C:\Program 
Files\HP\Service Manager 9.30\Search Engine Backup

 2. Make a backup of the files to be modified by the unload files in the KM patch.

 3. Make a backup of your schemastub.xml file under directory <SM server>/RUN/km/styles/.

Backout
After installing the patch, do the following to backout:

 1. Stop your KM search engine.

 2. Remove the existing search engine installation folder.

 3. Copy the backup folder back.

 4. Rollback the previous JDK installation and change the JAVA_HOME environment variable back.

 5. Be sure to roll back KM related changes on the Service Manager server and application sides, 
including the kmsolr unloads files and the server's schemastub file.

 6. Restart your KM search engine.

 7. Perform a full re-indexing on all of your knowledgebases.
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Installation notes
This section provides instructions on installing each component in this patch release. You can also 
refer to the Service Manager 9.34 Upgrade Documentation Center, which is available to download from 
the following HP Software Manuals website: 

http://support.openview.hp.com/selfsolve/manuals

Before you proceed, HP recommends that you consult the latest Service Manager 9.34 Support Matrix 
and the Compatibility Matrix for Service Manager Applications Content. These are available at the 
following website:

http://support.openview.hp.com/sc/support_matrices.jsp

About HP ITSM Deployment Manager

Service Manager 9.34 release is supported by HP ITSM Deployment Manager (referred to as 
Deployment Manager). Deployment Manager is a free administration tool provided by HP that can help 
you deploy and maintain your Service Manager environments as well as ease the setup and 
maintenance of Service Manager integrations with other HP products. HP highly recommends you to 
download Deployment Manager and use it to re-deploy your environment when upgrading to Service 
Manager 9.34.

You can download Deployment Manager from the following HP Live Network web site for free and 
access all information on its compatibility matrix and features: 

https://hpln.hp.com/group/itsm-deployment-manager

Digital signature notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has been 
updated to use a new VeriSign root certificate. On a Windows system that does not have the new 
VeriSign root or intermediate certificate installed, when the user right-clicks the file and then goes to 
Properties > Digital Signatures > Details, the following verification error is displayed: 

The certificate in this signature cannot be verified.
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To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as 
documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140

Server update installation
The server update for your operating system consists of a compressed file, sm9.34.0032_<OS>.zip (or 
.tar), which contains updated files of the Service Manager server. These files add to or replace the files 
in the [SM Server Root]\([SM Server Root]/)RUN, irlang, bin, legacyintegration, and platform_unloads 
directories. 

Note: If you use an Oracle RDBMS, be aware that Oracle Call Interface (OCI) 11.2.0.3 is required 
for Service Manager 9.30p5, Service Manager 9.31, Service Manager 9.32 and later. For more 
information, see the latest Service Manager 9.34 Support Matrix at 
http://support.openview.hp.com/sc/support_matrices.jsp. 

Built-in troubleshooting tool (SM Doctor)
Additionally, as of Service Manager 9.32, the server patch includes an installation of the HP Service 
Manager Doctor (SM Doctor) tool. The server patch will install the tool in the <SM server root>\(<SM 
server root>/)smdoctor directory. For information on how to use this tool, see the Guides and reference 
> Troubleshooting > HP Service Manager Doctor section in the online help.
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Upgrade paths
This server patch must be applied on top of one of the following versions/patch levels of the Service 
Manager server:

 l 9.30 GA, or 9.30 Patch/Hotfix

 l 9.31, or 9.31 Patch/Hotfix

 l 9.32, or 9.32 Patch/Hotfix

 l 9.33, or 9.33 Patch/Hotfix

The following server upgrade paths are recommended:

 l New customers: Install the Service Manager 9.30 GA server, and then directly apply this server 
patch.

 n If you are using Solaris 11.1, be sure to enable non-UTF-8 locales. See "Enabling non-UTF-
8 locales in Oracle Solaris 11.1" below.

 n If you are using Windows Server 2012, be sure to install the Service Manager server in 
compatibility mode. See "Compatibility mode for installation on Windows Server 2012" on 
the next page.

 l Existing SC6.2, Service Manager 7.11, and Service Manager 9.21 customers:  Uninstall the old 
server, install the Service Manager 9.30 GA server, and then apply this server patch.

 l Existing Service Manager 9.30, 9.31, 9.32 and 9.33 customers: Apply this server patch.

For installation instructions of the Service Manager 9.34 server, see the Service Manager 9.34 Upgrade 
Documentation Center, which is available to download from the following HP Software Manuals 
website: 

http://support.openview.hp.com/selfsolve/manuals

For installation instructions of the server patch, see "Server patch installation steps" on the next page.

Enabling non-UTF-8 locales in Oracle Solaris 11.1
Oracle Solaris 11.1 is supported as of Service Manager 9.34. However, because non-UTF-8 locales are 
packaged separately in  Oracle Solaris 11.1, you must enable charset ISO88591 on Oracle Solaris 11.1  
by executing the following command before you install Service Manager:

pkg install pkg:/system/locale/extra

For more information, see the following link:
http://docs.oracle.com/cd/E23824_01/html/E24456/glmwl.html
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Compatibility mode for installation on Windows Server 
2012
As of Service Manager 9.32, Windows Server 2012 is supported. Be aware that compatibility mode is 
required for installing the SM9.30 GA server on Windows Server 2012 (not required for Windows Server 
2008). To run your server installation in compatibility mode, do the following:

 1. Right–click the server's setupwin32.exe file icon.

 2. Click Properties > Compatibility.

 3. Click Run this program in compatibility mode for, and then select Windows Vista (Service 
Pack 2).

 4. Click Apply, and then click OK.

 5. Run the setupwin32.exe file to complete the installation.

When you uninstall your server on Windows Server 2012, you should also use compatibility mode. To 
do this, set your Windows server uninstaller file (_uninst\uninstaller.exe) to compatibility mode as 
described above, and then uninstall the server using the uninstaller or Control Panel.

Server patch installation steps

Caution:   

 l The server patch will upgrade your embedded Tomcat to version 6.0.37, and therefore requires 
additional steps.

 l The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2. 

 l Starting with Service Manager 9.31p2, the Service Manager server requires JRE 1.7. For 
Windows and Linux,  the embedded JRE has already upgraded to version 1.7; for other Unix-
based platforms, you need to manually perform this JRE upgrade. 

The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint 
does not support Server Name Indication (SNI), which is by default activated in JRE 1.7. Once 
Service Manager is upgraded to use JRE 1.7, it starts to use SNI extensions during the SSL 
handshake. If the remote endpoint does not support SNI, the web service call will fail with an 
error message. To solve this issue, do either of the following: 

 n Activate SNI at the remote end point (recommended)

 n If the remote endpoint does not support SNI extensions, and SNI cannot be activated, add 
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the following JVMOption<n> parameter either to the sm.ini file, or to the start command of 
the servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=false

Note: If you have a horizontally-scaled system, you must upgrade all your server instances.

 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Make a backup of the Server installation directory. See also "Backup and backout instructions" on 
page 128.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.37 when 
you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory. 

 7. Extract the compressed files for your operating system into the main Service Manager directory on 
the server. By default, the file is saved in the following location:  

C:\ProgramFiles\HP\Service Manager 9.30\Server

 8. For UNIX servers, set the file permissions for all Service Manager files to "755."

 9. For the following Unix servers, manually upgrade to one of the following JRE versions, if you have 
not already done so.

 a. Install either JRE1.6, or JRE1.7, as appropriate for your platform.

Solaris 9 JRE1.6 (update 20 or greater)

Solaris 10, 11.1 JRE1.7 (update 60 or greater)

HP-UX JRE1.7 (JRE_7.0.09 or greater)

AIX JRE1.7 (SR6 FP1)

Caution: Service Manager can run on Solaris 9 with JRE 6. However, HP recommends 
that you upgrade to Solaris 10 or 11.1 to take advantage of JRE 7. If you still want to run 
the server on Solaris 9, an extra configuration is required. Without this configuration, 
when you start the Service Manager server, the following error will occur: 
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" fatal: libm.so.2: open failed: No such file or directory. " 

This is a fundamental problem of Solaris 9, because there is no " libm.so.2 " on Solaris 9, 
while the Service Manager server requires this " libm.so.2 " to work. Use the following 
configuration to avoid this issue: 

i. Log in to server host as a root user.

ii. Run the following commands to create a link between limb.so.1 and limb.so.2:

n cd /usr/lib n ln - s libm.so.1 libm.so.2

iii. Run the export LD_ NOVERSION=1 command to set the environment variable LD_
NOVERSION.

b. Set your JAVA_HOME environment variable to point to JDK (if you have JDK installed) or
JRE (if you have only JRE installed).

c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute
\RUN\setupLinks.sh to create new symbolic links.

d. Run the following command to check that the JRE version is correct:

RUN\jre\bin\java –version

10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them in
the new RUN/tomcat folder.

11. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been
updated to a newer version. Either keep your old file by copying it back or keep the updated
version (a KM knowledgebase full reindexing is then required).

12. Run the sm -unlockdatabase command.

Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required 
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The 
purpose of this step is to prevent stale license information from being kept in the system. In a 
scaling implementation, you can run this command from any one of your servers.

13. Restart the Service Manager server.

14. Restart the Service Manager clients.

15. Check the version in Help > About Service Manager Server.

The server should be Release: 9.34.0032.
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Web tier installation
The web tier update consists of a compressed file, sm9.34.0032_Web_Tier.zip, which contains the 
installation files (both the .war and .ear files) that are required to install the HP Service Manager 9.34 
web tier. Installing the new web tier will upgrade your web client to this release level.

For installation instructions, see the Service Manager 9.34 Upgrade Documentation Center, which is 
available to download from the following HP Software Manuals website: 

http://support.openview.hp.com/selfsolve/manuals

New customers
You only need to install the new web tier using the .war or .ear file from the sm9.34.0032_Web_Tier.zip 
file in this release. 

Existing customers
To upgrade your web tier to this patch level, you must back up and uninstall your old web tier, and then 
install the new web tier.  The upgrade does not automatically save your web tier customizations. To 
keep your changes, you must back up your customized files and restore your customizations in the 
new deployment.

Note: If you plan to deploy the web tier on Tomcat 7.0 by using the Tomcat Manager, you must set 
the max-file-size and max-request-size parameters (default: 52428800) in the <Tomcat 7.0_
Home>webapps\manager\WEB-INF\web.xml file to a value greater than the size of the web tier 
.war file, otherwise the deployment request will be rejected because the web tier .war file exceeds 
the default maximum values. This restriction does not exist in Tomcat 6.0.

To install the new web tier, follow these steps:

 1. Make the necessary backups. For more information about how to do this, see "Backup and 
backout instructions" on page 128.

 2. Delete or uninstall the existing web tier .war (or the .ear) file.

 3. Clear the cache of your web application server.

 4. Deploy the new webtier-9.34.war (or .ear) file by following the instructions in the Service Manager 
9.34 Upgrade Documentation Center.

Note: It is best practice to deploy with a unique context root. For example, /webtier-9.34.0032
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 5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to 
ensure that any new parameters are properly merged into the files used in your final deployment. 
Do this for application-context.xml as well as any other files you may have customized (such as 
style sheets and splash screens).

 6. Make any new customizations that are necessary for your deployment.

 7. Restart the web application server.

 8. Check the version by clicking the HP logo (About HP Service Manager) icon.

The web tier version should be: 9.34.0032.

Windows Client Installation

Note: No features are being added to the Service Manager Windows (Eclipse) client.  HP 
recommends that Service Manager administrators deploy one of the other three clients (web client, 
SRC client or Mobility client) to end users.  You still need the Windows client to perform 
administrative tasks.

The Windows client update consists of a compressed file, sm9.34.0032_Windows_Client.zip, which 
contains the executable installation files of the new Windows client. Installing the new Windows client 
will upgrade your Windows client to this patch level.

For installation instructions, see the Service Manager 9.34 Upgrade Documentation Center, which is 
available to download from the following HP Software Manuals website: 

http://support.openview.hp.com/selfsolve/manuals

New Customers
You only need to install the new Windows client.

Existing Customers
You need to back up and uninstall the old Windows client, and then install the new Windows client. 

To install the new Windows client:

 1. Stop the Service Manager Windows client.

 2. Make necessary backups. For details, see "Backup and backout instructions" on page 128.
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 3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)

 4. Run setup.exe from this Windows client patch to install the new client.

 5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.34.0032.

Windows Client Configuration Utility installation
Service Manager 9.34  includes an updated version of the Windows Client Configuration Utility 
(sm9.34.0032_Windows_Client_Configuration.zip). 

For installation instructions, see the Service Manager 9.34 Upgrade Documentation Center, which is 
available to download from the following HP Software Manuals website: 

http://support.openview.hp.com/selfsolve/manuals

Applications update installation

Note: Upgrading your applications to version 9.34 is optional. Before upgrading your applications, 
you must first upgrade your server and Windows or web client. 

You apply the 9.34 applications using either the Service Manager 9.34 Applications Patch Manager 
(sm9.34.0032_Application.zip) or Upgrade Utility (sm9.34.0032_Application_Upgrade.zip) 
depending on your current application version. You must also be aware of the dependencies if you have 
already installed or plan to install Service Manager 9.3x content patches.

Upgrading to the 9.34 applications

Note: For upgrades from Service Manager 7.1x, .9.2x, 9.30, or 9.31, make sure that primary key 
mode is disabled before upgrading from the Service Manager 7.1x, 9.2x, 9.30, or 9.31 applications; 
for new installations of Service Manager, make sure that primary key mode is disabled before 
loading the OOB applications data. 

Existing customers and new customers can upgrade to the 9.34 applications using different 
approaches. For installation instructions, see the SM9.34 Upgrade Documentation Center, which is 
available to download from the following HP Software Manuals website: 

http://support.openview.hp.com/selfsolve/manuals

For existing customers:
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 1. Upgrade the Service Manager server and clients to version 9.34. 

 2. To upgrade from a 9.3x version of the applications, use the Service Manager 9.34 Applications 
Patch Manager.

 3. To upgrade from the 6.2, 7.11, or 9.21 applications, use the Service Manager 9.34 Upgrade Utility.

For new customers:

 1. Install the Service Manager 9.30 GA server and load Service Manager 9.30 GA demo data.

 2. Install the Service Manager 9.34 server patch. 

 3. Install the Service Manager 9.34 Windows or web client.

 4. Upgrade to the Service Manager 9.34 applications using the Service Manager 9.34 Applications 
Patch Manager.

Prerequisites

 l Service Manager applications release level
 n If using Applications Patch Manager: 9.3x (9.30, 9.30 Applications Patch, 9.31, 9.32, or 9.33) 

 n If using Upgrade Utility: 6.2, 7.11, or 9.2x

 l Service Manager applications release language: Any languages supported by Service Manager 9.34

 l Service Manager client and server release level: 9.34 or greater

 l The Service Manager server process must have read-write access to the database

Content patch dependencies

Refer to the Compatibility Matrix for Service Manager Applications Content document, which is 
available from the HP Support Matrices portal: 

http://support.openview.hp.com/sc/support_matrices.jsp

Application Unload installation

Note: All unload files in the server’s platform_unloads directory in this release have been already 
merged into the Service Manager 9.34 applications. These files are provided just in case you do 
not plan to upgrade to applications 9.34 while still want to take advantage of the relevant new 
features/fixes.

If a platform fix (in most cases, a server fix) also requires an applications change to resolve the relevant 
issue, an unload file is provided. Unload files introduced in earlier patches are also included in this 
cumulative release. If you have not already applied them for a previous patch, you should also apply the 
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unload files that are intended for your applications version. For more details about these applications 
updates, see the Release Notes for those patches.

This patch release includes the unload files that come with the server update. When you extract 
sm9.34.0032_<OS>.zip (or .tar), it will add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 
should be applied first, then those introduced in patch 2, and so on. However, unload files 
introduced in the same patch can be installed in a random order, unless otherwise specified.

Unload File Naming Convention

The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For 
example, QCCR1E12345. 

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 
patch 2 and should be used for patch 2 or higher.

Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. 
This example means the unload file is intended for Service Manager 7.11 patch 16 Hot Fix 8 or 
higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, 
SM711, which means the unload file is intended only for Service Manager applications version 7.11.

Note: If the applications version suffix is omitted, the unload file is then intended for all 
applications versions compatible with the server version, unless otherwise specified. For 
example, QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 
9.20, and 9.30 (which are compatible with Service Manager server 9.30), unless otherwise 
specified in the unload file description. For information on the applicable applications versions 
for each unload file included in the current patch, see Unload Files Included in the Current 
Patch.

Unload Files Included in the Current Patch

The following are unload files included in the current patch release.

Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version(s) Description

QCCR1E103581_
SM934_SM932.unl 

9.34 9.32, 9.33 Adds support for the auto-complete feature in 
the web client.

Associated web client fix: QCCR1E103581
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Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version(s) Description

QCCR1E103456_
SM934_SM932.unl 

9.34 9.32, 9.33 Enables the "Any of these words" text search 
option when you export records to Excel or to a 
text file.

Associated server fix: QCCR1E103456

QCCR1E106292_
SM934.unl 

9.34 7.11, 9.21, 
9.30, 9.31, 
9.32, 9.33

Enables caching of the globallist and locallist 
files.

Associated server fix: QCCR1E106292

QCCR1E99147_
SM933_SM930.unl

9.33 9.30, 9.31, 
and 9.32

Fixes an issue in which the first tab of a 
Notebook is reset to be the active tab when a 
new interaction is opened through the "Return to 
blank interaction" environment settings.

Associated server fix: QCCR1E99147

QCCR1E99398_
SM932P2.unl

9.32p2 7.11, 9.21, 
9.30, and 
9.31

Enables the inactivity timer function to work 
correctly when the version of applications is 
lower than the version of the server.

Associated server fix: QCCR1E99398

QCCR1E19946_
SM933.unl

9.33 7.11, 9.21, 
9.30, 9.31, 
and 9.32

Enables extra columns in the "Attachments" 
section of records.

Associated server fix: QCCR1E19946

QCCR1E31324_
SM932.unl

9.32 7.11, 9.21, 
9.30 and 
9.31

Fixes this issue : With Syslog audit turned on, 
only a syslog record showing login is created; 
no record for logoff is recorded if the user does 
not log out "normally."

Associated server fix: QCCR1E31324

QCCR1E96802_
SM931P3.unl

9.31p3 7.11, 9.21, 
9.30 and 
9.31

Changes the behavior when handling web 
service request user passwords. See the 
SM9.31p3 Release Notes.

Associated server fix: QCCR1E96802

QCCR1E52767_
SM931P3_
SM930.unl

9.31p3 9.30 Fixes the issue that users cannot add data 
policy definitions on joined tables. 

Note: You do not need to load this unload if you 
are running on SM9.31, 9.21, or 7.11 
applications.

Associated server fix: QCCR1E52767
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Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version(s) Description

QCCR1E76724_
SM931P2_
SM930.unl

9.31p2 9.30 and 
9.31

Fixes the issue that after deleting the unique 
key of cm3r, a signal 11 happened while doing 
an IR regeneration.

Associated server fix: QCCR1E76724

QCCR1E76227_
SM930P6_
SM930.unl

9.31 9.30 Contains the code changes to support 
localization of incident/change priority and 
urgency strings for the 9.31 Mobility Client.

Note: Not needed for the SM9.32 or later 
Mobility client.

QCCR1E78794_
SM930P6_
SM930.unl

9.31 9.30 Removes incident.assignee when a Web 
Service call specifies the assignee as 'NULL' 
through the SM9.31 Mobility Client.

Note: Not needed for the SM9.32 or later 
Mobility client.

QCCR1E76796_
SM930P6_
SM930.unl

9.31 9.30 Provides the ability to turn on debugging 
dynamically for user sessions or schedulers.

Note: This unload requires the SM9.31 
server.

QCCR1E71099_
SM930P5_
SM711.unl

9.30p5 7.11 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when 
adding a field by using Modify Columns.

Associated server fix: QCCR1E71099

QCCR1E71099_
SM930P5_
SM920.unl

9.30p5 9.20 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when 
adding a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E71099_
SM930P5_
SM930.unl

9.30p5 9.30 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when 
adding a field by using Modify Columns.

Associated server fix: QCCR1E71099 
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Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version(s) Description

QCCR1E71139_
SM930P5_
SM930.unl

9.30p5 9.30 Works with server fix QCCR1E71139 to solve 
this issue: When Service Manager is configured 
to use LDAP as the authentication data source, 
the user is still forced to change the password if 
the user is expired in the local database.

QCCR1E31941_
SM930P4_
SM930.unl

9.30P4 9.30 Enables users to use a pre-configured decimal 
symbol when completing numeric fields. 

Note: This enhancement requires a 9.30p4 
or later server; however if you are using 
RTE version 9.30 with applications version 
7.11 or 9.20, do not load this unload file; 
you can safely upgrade your server to 
9.30p4 or later without applying this 
applications change.

Associated server fix: QCCR1E31941.

QCCR1E73452_
SM930P4.unl

9.30P4 7.11 - 9.30 Enables Mandanten restricting queries to be 
updated correctly after a profile is edited.

Associated server fix: QCCR1E71897

QCCR1E67072_
SM930P4_
SM930.unl

9.30P3 7.11 and 
9.20

Enables users to take advantage of the new 
KMStatusListener background process.

Note: This unload file is not needed for 
applications version 9.30 or later, which 
supports only the Solr Search Engine.

Associated server fix: QCCR1E67071

QCCR1E70163_
SM930P4_
SM711.unl

9.30P3 7.11 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E70163_
SM930P4_
SM920.unl

9.30P3 9.20 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E70163_
SM930P4_
SM930.unl

9.30P3 9.30 Fixes the issue that the KMUpdate process 
terminates abnormally.

Associated server fix: QCCR1E69687
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Unload file

Introduced 
in  9.3x 
patch

Used for 
apps 
version(s) Description

QCCR1E67647_
SM930P3.unl

9.30P3 7.11 - 9.30 Updates the exception message that occurs in 
the request response when closing an 
interaction by calling CloseInteraction from a 
web service without specifying the 
localSolution field in the request.

Associated server fix: QCCR1E54192

QCCR1E67610_
SM930P2.unl

9.30P2 7.11 - 9.30 Enables you to block potentially dangerous 
attachments.

Associated server fix: QCCR1E64290

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended 
to use Unload Manager to load an unload file, because Unload Manager can help you create a 
backup of your old data and reconcile conflicts during the installation of the unload; if your 
application version is other than any of these, Unload Manager is not available and you can use 
Database Manager instead. 

To load an unload file using Unload Manager:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of 
the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To load an unload file using Database Manager:
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 1. Make sure the Windows client is configured for server-side load/unload.
 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

 3. Right-click the form or open the More Actions menu and select Import/Load.

 4. Browse to the unload file, and view the contents of an unload file before importing it by clicking 
List Contents.

 5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backup and 
backout instructions" on page 128.

 6. Fill in the following fields.

Field Description

File Name Type the name and path of the file to 
load.

Import Descriptor Since unload files do not require an 
Import Descriptor record, leave this field 
blank.

File Type Select the source operating system of 
the unload file.

Messages Option —  

All Messages Select this option to see all messages 
that Service Manager generates loading 
the file.

Messages Option —  

Totals Only Select this option to see only the total 
number of files Service Manager loads.

Messages Option — 
None

Select this option to hide all messages 
that Service Manager generates when 
loading the file.

 7. Click Load FG.
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Service Request Catalog (SRC) installation
Service Manager 9.34 includes the SRC package (sm9.34.0026_SRC.zip), which contains the 
following files:

 l a .war file for SRC 9.34 (src-9.34.war)

 l a migration tool for upgrading customizations from an SRC 1.4, SRC 9.32, or SRC 9.33 deployment 
to SRC 9.34 (src-migration-9.34.zip)

 l an encryption tool for generating an encrypted password (encryptor-9.34.zip)

 l a validation tool that you can use to help ensure that your manifest.xml file is valid and usable 
(validator-9.34.zip)

 l documents including the new Help document for SRC 9.34 (SRC9.34_Help_Center.zip)  

Note: The  Service Request Catalog online help was not translated in the 9.34 release and in 
previous 9.33 release. Because of this, the default online help remains the 9.32 version for all 
non-English languages. However, the English language 9.34 version of the online help is 
accessible from both the product user interface and the /docs directory in the SRC 9.34 
package. 

Before you proceed, download the Service Request Catalog 9.34 Interactive Installation Guide and 
Service Request Catalog 9.34 Customization Guide from the HP Software Manuals Site: 

http://h20230.www2.hp.com/selfsolve/manuals

These guides provide details about deploying the .war file and the usage of the three tools.

Note: Users who want to use Service Request Catalog on their tablet devices can download the 
HP Service Request Catalog app to their device from Google Play or the Apple Appstore. To 
locate these apps, search for "HP SRC" in the appropriate store.

The HP Service Request Catalog 9.34 tablet app supports Service Request Catalog versions 9.34 
and 9.33 (the SRC .war file).             

New Customers

 1. Install SRC 9.34, deploy the src-9.34.war file by following the instructions in the Service 
Request Catalog 9.34 Interactive Installation Guide.

 2. Configure SRC 9.34 by following the instructions in the Service Request Catalog 9.34 
Customization Guide.

Existing Customers
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 1. Install SRC 9.34, as described above.

 2. Migrate your customizations from the old deployment to SRC 9.34. 
 n SRC 1.4, SRC 9.32, and SRC 9.33 customers: Run the SRC migration tool to migrate your 

specific customizations from your old SRC deployment to SRC 9.34. For details, see the 
Service Request Catalog 9.34 Customization Guide.

 n SRC 1.2x or 1.3 customers: Manually restore your customizations.

Mobile Applications  installation
Service Manager 9.34 includes a new version of the Mobility client (sm9.34.0021_Mobility.zip). New 
customers can directly install the new Mobility client by deploying the webapp-9.34.0021.war file, while 
existing customers can only uninstall their old Mobility client and then install the new one.

Installation Steps

Note: The Service Manager 9.34 Mobility client supports Apache Tomcat 7.0 (7.0.54 or greater) 
and and IBM WebSphere 8.5 (8.5.5 or greater) web application servers. 

For more information about how install the Service Manager 9.34 Mobility client, refer to  the Service 
Manager 9.34 Mobile Applications User Guide.

Application changes required for SM9.31 and for SM9.30

The Service Manager 9.34 Mobility client can work with the SM9.34, SM9.33, SM9.32, SM9.31, or 
SM9.30 applications; however, if using the SM9.31 or SM9.30 applications, before users can use the 
Mobility client, you  need to make additional application changes by either importing or manually 
implementing the unload files shipped with the Mobility client package (be sure to import or implement 
them in listed order):

 l mobile2-update-9.30-9.31.unl 

 l mobile2-new-9.30-9.31.unl (If using the SM9.31 or SM9.30 applications with PDCP4 applied, load 
mobile2-new-9.31-pd4.unl instead)

For details, see the Service Manager 9.34 Mobile Applications User Guide.

Knowledge Management (KM) Update Installation
The KM package (sm9.34.0032_KM.zip) in this release includes updated files for the KM Solr Search 
Engine and the KM Import Utility. It also includes a zip file for knowledge content provided by 
KnowledgeBroker, Inc. (KBI).
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KM Search Engine Update Installation
The KM Search Engine update contains the following files:

Folder Files

kmsolr_unloads  l QCCR1E67750_SM930P4_SM930.unl

 l QCCR1E75104_SM930P5_SM930.unl

 l QCCR1E77409_SM930P5_SM930.unl

 l QCCR1E91035_SM932_SM930.unl

knowledgemanagement  l installasservice.cmd and startup.cmd (updated for JDK7 support 
added in 9.31p2)

 l kmsearchengine subfolder (which contains several search engine 
fixes)

 l tomcat folder (which contains an updated web.xml of the embedded 
Tomcat)

The Solr Search Engine update aims to enable the following features or fixes for Knowledge 
Management searches:

 l Support of Knowledge Management search for Service Request Catalog (SRC) 1.4 or greater. For 
more information, see the SM9.31 Release Notes.

 l Ability to specify search result sort preferences in Knowledge Management (by Modified Date, 
Status, or Relevancy). For more information, see the SM9.30p4 Release Notes.

 l Ability to select whether or not to highlight attachment content in KM search results. A new option 
(Highlight content of attachment in search result?) is available in the KM environment record. 
By default, this option is not selected, and therefore attachment content in user’s KM search results 
will not be highlighted. This can significantly improve search performance when there are a large 
number of large-size attachments like PDF manuals in the knowledgebases. For more information, 
see the Highlighting Attachment Content in Search Results Optional section in the 9.30p5 Release 
Notes.

 l Fix QCCR75104 (Searches that use "NOT" or '-' to exclude terms produce unexpected results. For 
example, the search results when using the None of these words option in Advanced Search may 
include the search terms that should have been excluded. For more information, see the 9.30p5 
Release Notes.
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 l JDK 7 support (QCCR1E90386): To use JDK7 on a Windows platform, you need to update your 
installasservice.cmd and startup.cmd files with those shipped with this KM patch; for UNIX 
platforms, no file changes are needed to use JDK7.

 l Fix QCCR1E91035 (which fixes the issue that search results using the None of these words 
option display incorrect total number of documents searched, and also provides the option to make 
search results highlight search words in attachments)

Prerequisites:

This KM Search Engine patch can be applied on top of any of the following versions of the KM Solr 
Search Engine:

 l SM9.30, or SM9.30 Patch/Hotfix

 l SM9.31 or SM 9.31 Patch/Hotfix

 l SM9.32 or SM9.32 Patch/Hotfix

 l SM9.33 or SM9.33 Patch/Hotfix

Compatibility Mode for Installation on Windows Server 2012

As of the SM9.32 release, Windows Server 2012 is supported. Be aware that compatibility mode is 
required for installing the SM9.30 KM search engine on Windows Server 2012. 

 1. Right–click the search engine's setup.exe file icon.

 2. Click Properties > Compatibility.

 3. Click Run this program in compatibility mode for and select Windows Vista (Service Pack 
2).

 4. Click Apply and OK.

 5. Run the setup.exe file to complete the installation.

When uninstalling your KM search engine on Windows Server 2012, you should also use compatibility 
mode. To do so, set your search engine uninstaller file (Search_Engine_Uninstall\change_or_
uninstall.exe) to compatibility mode as described above and then uninstall the search engine using 
the uninstaller or from your Control Panel.

KM Search Engine patch installation steps

To install the KM Search Engine update:

Note: JDK 7 Update 17 and Tomcat 6.0.36 have been certified on this release of the KM Search 
Engine. Upgrading to JDK 7 or Tomcat 6.0.36 is optional but recommended.
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 1. Stop your KM Search Engine.

 2. Make a backup of your Search Engine installation folder and other necessary backups. See the 
instructions in "Knowledge Management search engine" on page 134.

 3. Optionally, update the JDK installed on your search engine server host to JDK7 Update 17, if you 
have not already done so.

Note: If you are using a Windows platform, be aware that if you do not update your JDK, later 
you will need to copy your old  installasservice.cmd and startup.cmd files back (located 
directly under your search engine backup folder).

 4. Optionally, update the KM embedded Tomcat to version 6.0.36.
 a. Download the Tomcat 6.0.36 zip file specific for your operating system.

Caution: The KM search engine requires a 32-bit  Tomcat if running on a 32-bit operating 
system, and a 64-bit Tomcat on a 64-bit operating system.

 b. Extract the zip file to overwrite your existing Tomcat folder. 

Caution: Before this step, be sure not to remove the embedded Tomcat folder, which 
contains certain files that do not exist in the Tomcat 6.0.36 zip file that you downloaded. 
This way these files will remain after you overwrite the old Tomcat folder.

 c. Copy your old Tomcat configuration file (server.xml in the conf folder) back to the updated 
Tomcat folder.

 5. Make sure you have already installed the SM9.34 server package.

Note: The server package will update your schemastub.xml file to support the new features. 
If you do not want to use the new features, copy your old schemastub.xml file back from the 
backup of your server’s RUN directory so that your search engine can continue to work.

 6. Copy all files and folders in the knowledgemanagement folder to your existing search engine 
installation folder (for example: C:\Program Files (x86)\HP\Service Manager 9.30\Search_
Engine).

 7. Load the unload files in the kmsolr_unloads directory into Service Manager in the following order: 

 n QCCR1E67750_SM930P4_SM930.unl

 n QCCR1E75104_SM930P5_SM930.unl

Release Notes
Installation notes

HP Service Manager (9.34) Page 155 of 162



 n QCCR1E77409_SM930P5_SM930.unl

 n QCCR1E91035_SM932_SM930.unl

Note: This step is required only when you are using an applications version earlier than 9.32. 
These unload files have been already merged into the SM9.32 applications.

 8. (Windows platforms only) If you selected to not update your JDK, copy your old  
installasservice.cmd and startup.cmd files back.

 9. Restart your KM search engine.

 10. Log off Service Manager and log back in for your changes to take effect.

 11. Perform a full re-indexing for all of your knowledgebases.

KM Import Utility Installation

Note: The km-import-9.34.zip file included in this release is same with the one shipped with 
previous releases.

Extract km-import-9.34.zip in the Knowledge Management package to a local drive. For detailed 
instructions on the use of the import utility, see the README file packaged in this .zip file.

KBI Demo Data
The KBI-Content-Shipment.zip file includes knowledge articles provided by KnowledgeBroker, Inc. 
(KBI) for HP Service Manager. You can import the knowledge articles into your production system 
using the KM Import Utility. For more information, see "KBI knowledge content" on page 36.

ODBC Driver update installation
This release does not contain any ODBC Driver update. The latest ODBC Driver package  has been 
shipped with the Service Manager 9.30p4, Service Manager 9.30p5, and Service Manager 9.31 
releases.

You can download the latest package from the following website:

 http://support.openview.hp.com/selfsolve/document/KM00207925

The ODBC Driver package contains the following updated files:
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 l Scodbc32.dll

 l sci18n.dll

 l sccl32.dll

To install the ODBC Driver update, follow these steps:

 1. Extract the files to your ODBC Driver installation folder. For example: C:\Program Files\Peregrine 
Systems\ServiceCenter 6.2\ODBC Driver.

 2. When prompted, replace the three old DLL files with the new ones.

Language Pack installation
Service Manager 9.34 includes language packs for the Service Manager server in 15 supported 
languages other than English. For a list of supported languages, see "Local language support" on 
page 160.

For detailed installation instructions, see the Service Manager 9.34 Language Pack Installation Guide, 
which is available from the HP Software Manuals website: 

http://h20230.www2.hp.com/selfsolve/manuals

Online Help installation
Service Manager 9.34 includes only an English version of the online help. For installation instructions, 
see the Service Manager 9.34 Interactive Installation Guide that is included in the Service Manager 
9.34 Upgrade Documentation Center. 

To download the Upgrade Documentation Center and the online help, visit the following HP Software 
Manuals website: 

http://support.openview.hp.com/selfsolve/manuals
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Service Manager support matrix and applications 
content compatibility matrix
The Support Matrix lists supported versions of operating systems, browsers, HP Software products, 
and other compatibility and support information.

The Applications Content Compatibility Matrix (named Compatibility Matrix for Service Manager 
Applications Content) provides compatibility information for Service Manager applications content 
packs (for example, Process Designer Content Packs). 

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require an active support contract. To find more information about support access levels, go to      
Access levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Support Matrix and Applications Content Compatibility Matrix:

 1. Use a browser to navigate to the Software Support Online (SSO) web page:

http://support.openview.hp.com/sc/support_matrices.jsp

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information.

HP Service Manager (9.34) Page 158 of 162

http://support.openview.hp.com/access_level.jsp
http://h20229.www2.hp.com/passport-registration.html
http://support.openview.hp.com/sc/support_matrices.jsp


Supportability
The scope of support is limited to the behavior of APIs and product features documented. HP is 
responsible for the correct operation of those features and APIs. HP is not responsible for debugging 
scripts or code created to utilize these features to implement a solution. In order to receive the best 
possible support, HP asks customers to provide a reproducible unit test scenario that demonstrates the 
error or unexpected behavior of the API or documented feature.
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Local language support
This section includes the localization information for this release.

User interface localization
The following table lists the supported languages for the Service Manager clients. All languages listed 
are supported, except the two right-to-left display languages (Arabic and Hebrew), which are not 
supported for the Mobility client. 

Language Windows Client Web Client Mobility Client SRC Client 

Arabic √ √ × √

Brazilian Portuguese √ √ √ √

Chinese Simplified √ √ √ √

Czech √ √ √ √

Dutch √ √ √ √

English √ √ √ √

French √ √ √ √

German √ √ √ √

Hebrew √ √ × √

Hungarian √ √ √ √

Italian √ √ √ √

Japanese √ √ √ √

Korean √ √ √ √

Polish √ √ √ √

Russian √ √ √ √

Spanish √ √ √ √
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Service Manager applications language packs
A language pack is available for each of the languages listed in the table above.
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